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Naming and Definition 

GV-Software 

GV-Software refers to all GeoVision applications that can be 

connected to and managed by GV-Control Center, which 

includes GV-NVR / VMS, GV-Recording Server, 

GV-ASManager, GV-AI FR, and GV-Live Streaming mobile 

app. See 1.1.2 Compatible GeoVision & USAVision Products. 

IP Devices 

IP devices refer to all GeoVision IP video devices, including 

GV-IP Camera, GV-Video Server, GV-Compact DVR, GV-IO 

Box, and GV-SNVR. See 1.1.2 Compatible GeoVision & 

USAVision Products. 

 

 

GDPR Practice 

For details on how GeoVision Inc. is committed to helping users become GDPR (General 

Data Protection Regulation) compliant, visit the GDPR Consent Request. 

 

 

https://dlcdn.geovision.com.tw/TechNotice/SW/GDPR_Consent_Requests.pdf
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GPU Decoding Specifications 

GPU (Graphics Processing Unit) decoding is added to lower the CPU loading and to increase 

the maximum frame rate. GPU decoding can be performed on onboard and/or external GPU 

under the following specifications. 

Onboard GPU: GPU decoding is only supported when using the following Intel CPUs: 

For H.264 Video Compression  

• 2nd ~ 8th Generation Intel Core i3 / i5 / i7 Desktop Processors 

• 9th ~ 14th Generation Intel Core i3 / i5 / i7 / i9 Desktop Processors 

• Intel Core Ultra 5 / Ultra 7 / Ultra 9 Desktop Processors (Series 2) 

 

For H.265 Video Compression 

• 6th ~ 8th Generation Intel Core i3 / i5 / i7 Desktop Processors 

• 9th ~ 14th Generation Intel Core i3 / i5 / i7 / i9 Desktop Processors 

• Intel Core Ultra 5 / Ultra 7 / Ultra 9 Desktop Processors (Series 2) 

External GPU: GPU decoding is only supported when using: 

• NVIDIA graphics cards with a compute capability of 3.0 or above and a memory of 2 

GB or above. To look up the compute capability of the NVIDIA graphics cards, refer to: 

https://developer.nvidia.com/cuda-gpus 

Note: Only one external NVIDIA graphics card is supported for GPU decoding, with up to 8 

MP resolution. 

Onboard GPU + External GPU: To have both the onboard and external GPU to perform 

GPU decoding, the GPUs must follow their respective specifications listed above. 

Note: 

1. If you have both onboard and external GPUs installed, the onboard GPU must be 

connected to a monitor for H.264 / H.265 GPU decoding. 

2. For NVIDIA graphics cards, CUDA compute capability 5.0 or higher is required to 

ensure optimal performance. 

 

https://developer.nvidia.com/cuda-gpus
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Software Specifications for H.264 and H.265 

GPU decoding is only supported under the following operating system, resolution, and codec. 

 
2nd Gen 

3rd ~ 4th 

Gen 
6th Gen 7th Gen 

8th ~ 14th 

Gen 

Core Ultra 

Series 2 

OS 64-Bit 

Windows 8 / 8.1 / 10 / Server 

2012 R2 / Server 2016 / Server 

2019 / Server 2022 

Windows 10 / 

Server 2016 / 

Server 2019 / 

Server 2022 

Windows 10 / 11 /  

Server 2016 /  

Server 2019 /  

Server 2022 

Resolution 1 MP / 2 MP 1 MP / 2 MP / 3 MP / 4 MP / 5 MP / 8 MP / 12 MP 

Codec H.264 H.265 H.264 / H.265 

Note: Make sure your PC meets the system requirements before installing or upgrading to 

Windows 11. See the Microsoft Website for details. 
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Note for Upgrading GV-Control Center 
To upgrade GV-Control Center, run the Installer (setup.exe) included in the latest software 

downloads from our website. Select Reinstall / Upgrade to start. 

https://www.geovision.com.tw/download/product/GV-Control%20Center
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Chapter 1  Introduction 
GV-Control Center is a central monitoring station solution (CMS) that provides the CMS 

operator with these major features:  

 

 Popup video alerts upon motion detection, input trigger, critical temperature and many 

more (See 4.7 VMD Monitoring) 

 Remote playback (See Chapter 5 Playback) 

 Access client GV-NVR (See 6.1 Remote DVR) 

 Access the desktop of client GV-NVR / VMS and the operating system (See 6.2 Remote 

Desktop) 

 Central management of I/O devices from different hosts (See Chapter 7 I/O Central 

Panel) 

 Display of 9 Live View windows, 100 camera channels for each Live View (See 8.2 

Setting up Multiple Live Views) 

 Video Wall (See 8.4 Video Wall) 

 Remote E-Map (See 9.1 Remote E-Map) 

 Support for 31 languages on the user interface 
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1.1  Minimum System Requirements 

Before installation, make sure your computer meets the following requirements. 

OS 64-bit Windows 10 / 11 / Server 2016 / Server 2019 / Server 2022 

CPU Core i7 2600K, 3.4 GHz 

RAM 16 GB Dual Channels 

Hard Disk 500 GB 

Processor Graphics Please see GPU Decoding Specifications above. 

DirectX 9.0c 

LAN Card Gigabit Ethernet x 2 

Note: 

1. It is not recommended to install GV-Control Center and GV-Center V2 on the same PC. 

Running the two software together may result in a CPU overload error or system failure. 

2. To display a megapixel IP channel across monitors, make sure the external graphics 

cards on a server are of the same brand, model, and driver version, and the capacity of 

the graphics cards is of NVIDIA GTS 450 or higher to ensure maximum efficiency. 

3. When you find CPU usage is high or live view is unsmooth (dropping frames), you may 

need to increase CPU threads and memory, or decrease the number of connected 

cameras to improve the system performance. 

4. For GV-Control Center to support up to 9 Live Views, with 100 camera channels for each 

Live View, higher PC specifications are required than the minimum requirements. 
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1 

1.1.1  License 

For details, see the License section in the datasheet. 

 

1.1.2  Compatible GeoVision & USAVision Products 

For details, see the Compatible GeoVision & USAVision Products section and the notes in the 

Specifications section in the datasheet. 

 

 

1.2  Options 

Optional devices can be purchased to assist your surveillance management. 

For details, see the datasheet. 

 

https://dlcdn.geovision.com.tw/Manual/Control-Center/EN/Datasheet_CC.pdf
https://dlcdn.geovision.com.tw/Manual/Control-Center/EN/Datasheet_CC.pdf
https://dlcdn.geovision.com.tw/Manual/Control-Center/EN/Datasheet_CC.pdf
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1.3  Overview 

 

1.3.1  The Main Screen 

 

1 2

3

4

6
5

7

8

9

10

 

 

No. Name Description 

1 
Log Database 

Status 
Display whether the log database is connected or not. 

2 Login Account 
Allows users to set up accounts and privileges, lock the session, switch 

accounts, and log out. See 2.2 Login Account Settings. 

3 Configure  

Access the general settings of the Control Center and other tools, 

import / export data, apply the current settings to other users, set up 

event rules, and search for bookmarked videos. See No. 6 in 4.1 Live 

View Window. 

4 List Mode 

List Mode -Tile hides the 4 buttons of Layout, Host List, Group List 

and Video Wall while List Mode - Cascade displays the 4 buttons 

under the List Mode. 

5 Layout Open / hide the Layout list. See 1.3.4 The Layout List. 

6 Host List Open / hide the Host List. See 1.3.2 The Host List. 

7 Group List Open / hide the Group List. See 1.3.3 The Group List. 

No. Name Description 

8 Video Wall Open / hide the Video Wall layout list. See 8.4 Video Wall. 

9 

Live View, 

Remote ViewLog, 

Video Wall, 

Log 

Display the live view, play back recordings, access Video Wall settings, 

and log data. 

10 
Move Tab to New 

Window 
Move a tab to another window. 
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1 

1.3.2  The Host List 

1
2

3
4

5

 

 

No. Name Description 

1 Add  
Add hosts and groups. To add GV-IP Speaker as a host, see 

GV-IP Speaker User’s Guide. 

2 Delete  Delete hosts and groups. 

3 Host Settings Opens host connection settings. 

4 Tools 

◼ Auto Set IP Address: See 3.1 Configuring the IP Address.  

◼ Upgrade Device Name: See 3.2 Renaming Devices. 

◼ Change Host ID and Password: See 3.3 Connecting to 

Hosts with Identical Credentials.  

◼ Face Manager: See GV-Face Manager User Guide. 

◼ Broadcast Service: See 4.8 Audio Broadcast. 

◼ Host Monitor: Enable to display the camera connection 

status under GV-VMS hosts. 

◼ Recording Server Management Tool: Click to launch. You 

must install it first from Utility on the GeoVision Website. 

5 Search Search for cameras in the list. 

https://s3.amazonaws.com/geovision_downloads/Manual/IP_Speaker/GV-IP_Speaker_User_Guide.pdf
https://dlcdn.geovision.com.tw/Manual/Face_Manager/GV-Face_Manager_User_Guide.pdf
https://www.geovision.com.tw/download/product/GV-Control%20Center
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1.3.3  The Group List 

1

2
3

4

5

 

 

No. Name Description 

1 Add  Add groups. 

2 Delete Delete groups. 

3 Group List Setting Opens Group List Settings: 

◼ Display Host Name in the Group List 

◼ Sort the Group List by Names 

◼ Application Startup Settings: Select the applications to be 

started along with GV-Control Center’s startup, including VMD 

System, I/O Central Panel, Remote E-Map, ASManager View, 

FR Watch, and AI Watch. 

◼ Listen Port: Lists the ports for VMD, FR Watch, and AI Watch. 

These ports enable communication with SNVRs for event 

transmission and typically do not need adjustment unless 

already in use. 

4 Tools ◼ Broadcast Service: See 4.8 Audio Broadcast. 

5 Default Groups ◼ VMD Group: See 4.7 VMD Monitoring. 

◼ I/O Panel Group: See Chapter 7 I/O Central Panel. 

◼ E-Map Group: See 9.1 Remote E-Map. 

◼ ASManager Group: See 4.11 ASManager View. 

◼ FR Group: See 4.9 Face Recognition Watch.  

◼ AI Watch Group: See 4.10 AI Watch. 
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1 

1.3.4  The Layout List 

1

2

3

4

5

 

 

No. Name Description 

1 Add  Add layouts or groups. 

2 Delete Delete layouts or groups. 

3 Properties ◼ Caption: Configure the text overlay of the live view and playback. 

◼ Image Ratio: Keep the image ratio of the live view and playback. 

◼ Force Substream: Disabled by default. For multi-channel layouts, 

this option forces both live view and playback to use the sub 

stream when available, increasing the number of full-frame 

channels supported. 

4 Tools  ◼ Matrix Quick Zoom: Display a camera view on the primary 

monitor when multiple monitors are used. See 8.3 Quick Zoom. 

5 Scan Window Drag the Scan Window to a live view grid and then cameras to the grid 

to display the cameras in sequence. See 4.2.3 Setting up Scan 

Window. 

Tip: Right-click a layout to copy its settings to another user account, set it as the default layout, 

or configure its properties 
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Chapter 2  Getting Started 
 

2.1  Installation 

Follow the steps below to install GV-Control Center. 

 

1. Go to the Download page of the GeoVision Website. 

2. To install GV-Control Center, select Primary Applications from the dropdown list to 

download the software. 

 

3. If you are using a GV-USB Dongle for licensing, insert the dongle to your computer.  

⚫ To install the USB device driver, select Driver, F/W, Patch from the dropdown list 

and download GV-Series Card Driver / USB Devices Driver. 

⚫ To verify the driver is installed correctly, go to Windows Device Manager and 

expand DVR-Devices. You should see GV-Series USB Protector. 

  

4. If you are using software license, click Windows Start > Control Center > Register 

GV-Control Center Platform to register the serial number purchased from GeoVision. 

For details, see First-Time Licensing in GV-Software Licensing. 

 

 

Note: SQL Server installation is required to enable log data recording in GV-Control Center. 

There are two installation choices for SQL Server: 

1. Install directly on the GV-Control Center server using the installer. For details, see this 

technical notice. 

2. Install independently on a separate server. For details, see this technical notice. 

http://www.geovision.com.tw/download/product/GV-Control%20Center
https://s3.amazonaws.com/geovision_downloads/TechNotice/VMS/Licensing_GV-SW.pdf
https://dlcdn.geovision.com.tw/TechNotice/SW/SQL_Server_Linked_Installation_for_Control_Center.pdf
https://dlcdn.geovision.com.tw/TechNotice/SW/SQL_Setup_for_Control_Center.pdf
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2 

2.2  Login Account Settings 

Upon first-time startup, the user will be prompted to set a login password for the Administrator 

account (default ID admin), which has access rights to all the settings of GV-Control Center. 

Click OK. You are logged in to GV-Control Center now. 

 

 

 

To access account-related settings, click the account ID at the top right of the main screen > 

Account Setup. The Account Management dialog box appears. Right-click the Administrator 

account to access its settings. 

       

 

 

 

Name Description 

Rename Changes the username of the account. 

Change Password Changes the login password of the account. 

Login This ID 

Automatically 

Select to automatically log in as the selected account when 

starting GV-Control Center. 

Note: See Chapter 11 Account Management for details on creating accounts, 

managing user privileges, and configuring security settings. 

 

Tip: To access the SQL settings after logging in to GV-Control Center, click Configure  

(top right of the main screen) > Setup > System Configure > the System Log tab.  
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2.3  Hosts and Groups 

You need to create hosts or groups before starting GV-Control Center services. To create 

hosts, you can use the Search Host function (Add button on the Host List > Add Host) to 

detect GV / UA devices and compatible third-party IP devices on the same LAN and add them 

to the Host List, or you can follow the steps in the following section. 

 
 

Note:   

1. To use the Search Host function to locate GV devices, it is required to open TCP port 

5201 on the client NVR / VMS, TCP port 5202 on the Video Server and Compact DVR, 

and UDP port 5200 on GV-Control Center.  

2. If antivirus software is installed, the Search Host function may be interfered and unable 

to detect any hosts. In this case, turn off the antivirus software and try again. 

 

IMPORTANT:   

If you are using software licensing, every time when you add a new host, you need to 

update the licensing by clicking the Configure button  (top right of the main screen) > 

License Request Generator > Adjust registered license > OK > Agree License 

Agreement. 
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2 

2.3.1  Creating a Host 

Create hosts for GV devices and software you like to monitor in GV-Control Center. The Host 

Settings dialog box may differ depending on the devices and software. The following steps 

demonstrate how to add an IP camera host. 

 

1. On the Host List, click the Add button > Add Host > Search Host.  

2. On the Host Settings dialog box, type the name, IP address, login ID and password of the 

host. Keep the communication port as default, unless otherwise necessary. 

 

 

3. Click the Update Information button  to request the number of cameras, I/O devices 

of the host.  

4. Optionally select Stream 1 or Stream 2 for live view display. By default, the Stream is set 

to Auto, and the received streaming is based on the streaming setting of the host. Select 

Single Auto for the received streaming to adapt when the live view sizes vary.  

5. Click OK. 

6. If you are using software licensing, every time when you add a new host, you need to 

update the licensing by clicking the Configure button  (top right of the main screen) > 

License Request Generator > Adjust registered license > OK > Agree License 

Agreement. 
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Tip:  

1. To access the Web interface of the camera / GV-Recording Server, click  on the 

Host Settings dialog box. 

2. To access the live view of the camera, drag and drop the camera from the Host List to 

any live view grids. 

 

Note:   

1. To add a GV-NVR / VMS host, it is required to enable Control Center Service in the 

host; otherwise the message “Unable to Connect” will appear when accessing the live 

view. See 2.4 Connecting to GV-NVR / VMS. 

2. To add a UA-IP camera / UA-HD DVR / UA-NVR host, click the Add button > Add Host 

> Add USAVision IP camera / Add USAVision HD DVR/NVR on the Host List. 

3. GV-Control Center supports IP video devices using RTSP, ONVIF and PSIA standards. 

To connect the IP device compatible with any of the standards, select Protocol from the 

Brand dropdown list. For details, see Appendix C. RTSP Streaming. 

4. To add a camera channel from GV-Live Streaming app, right-click Live Stream List > 

Add Live Streaming Account, type Account e-mail and Binding Code of GV-Live 

Streaming account. For details, see Connecting to GV-Software in GV-Live Streaming 

Installation Guide. 

  

 

 

https://dlcdn.geovision.com.tw/Manual/GV-LiveStreaming/GV-LiveStreaming_InstallationGuide.pdf
https://dlcdn.geovision.com.tw/Manual/GV-LiveStreaming/GV-LiveStreaming_InstallationGuide.pdf
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2 

2.3.2  Creating a Group 

You can group different hosts or cameras, by location or purpose, under the Host List or the 

Group List. 

 

On the Group List, default group folders have already been created for specific functions 

such as VMD (Video Motion Detection), I/O Panel, E-Map, ASManager and FR. You can 

also create additional groups to apply Remote ViewLog, and Privilege Setting to the cameras 

within the group collectively. 

 

To create a group:  

1. On the Host List / Group List, click the Add button > Add Group.  

2. Name the created group.  

3. On the Host List, drag the desired hosts to the group.  

 

Note: You can grant access to a group created in the Group List. By default, only 

Administrator has access. Log in with an Administrator account, right-click a group, select 

Privilege Setting, select User or Power User and select accounts to allow access to this 

group.  
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2.4  Connecting to GV-NVR / VMS 

GV-Control Center supports several types of hosts. Only GV-NVR / VMS hosts need to be 

configured ahead to allow remote access from GV-Control Center. To configure GV-NVR / 

VMS, click the Network button on the main screen > Control Center Server (or Control 

Center / ERM Service for GV-VMS V18 / V20), and select Start Default Service or Start All 

Service to connect. 

 
 

2.4.1  The Control Center Server Window 

When GV-NVR / VMS starts Control Center Server as described above, the server will be 

minimized to the system tray. Click the server’s icon to restore its window. 

 

GV-NVR 

 

1 3 4 5 6

7
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2 

 

GV-VMS V17 GV-VMS V18 / V20 

13 4 5

6

2

8

 

5

8

2 13

 

 

No. Name Description 

1 Stop All Service Stop all Control Center Server services.  

2 Start Default Service Start all default services. 

3 
Start / Stop  

Control Center Service 

Start / stop the services: Live View, I/O Central Panel and 

Remote DVR. 

4 
Start/Stop Remote 

ViewLog Service 
Allow / deny GV-Control Center to access the recordings. 

5 
Start/Stop Desktop 

Service 
Allows / deny GV-Control Center to control the desktop. 

6 

Start / Stop 

Bandwidth Control 

Service 

Allows / deny the Bandwidth Control Server to control the 

bandwidth. See Bandwidth Control in the GV-DVR / NVR 

User’s Manual, GV-VMS User’s Manual V17, or GV-VMS 

User’s Manual V18. 

7 Event List 
Indicate login ID, event type, event time, service activated and 

IP address. 

8 Configure See 2.4.2 Advanced Settings.  

 

 

Note:   

1. By default, the live streams of GV-NVR / VMS are compressed for better bandwidth 

control at the cost of increased CPU usage. The number of remote connections allowed 

from a single GV-NVR / VMS depends on the specs and the CPU usage of GV-NVR / 

VMS. 

2. For GV-VMS V17.1 or later, optionally enable the Substream FIFO function in the 

Configure button of CMS Service (see No. 8 in the above figure) for reduced CPU 

usage of GV-VMS and improved streaming quality at the cost of increased bandwidth. 

The number of remote connections allowed from a single GV-VMS depends on the 

amount of bandwidth available. 

3. To access one GV-VMS host from multiple Control Center servers under the same LAN, 

the Multicast function is recommended. For details, see 9.4 Multicast Setting. 

 

https://dlcdn.geovision.com.tw/Manual/DVR/EN/GV-DVR_NVR_UserManual.pdf
https://dlcdn.geovision.com.tw/Manual/DVR/EN/GV-DVR_NVR_UserManual.pdf
https://dlcdn.geovision.com.tw/Manual/VMS/EN/GV-VMS_User_Manual_17.pdf
https://dlcdn.geovision.com.tw/Manual/VMS/EN/GV-VMS_User_Manual_181.pdf
https://dlcdn.geovision.com.tw/Manual/VMS/EN/GV-VMS_User_Manual_181.pdf


 
 

 16 

2.4.2  Advanced Settings 

To configure Control Center Server, click the Configure button  on the window menu.  

 

[Network Settings] Keep the communication ports as default, unless otherwise necessary. 

 

 

GV-NVR 

 

GV-VMS V17 

 

GV-VMS V18 / V20 

 

 

◼ Enable IP White List: Limit access to GV-Control Center Server by assigning IP ranges. 

◼ Codec: Set video compression to Geo Mpeg4 or Geo H264. Note that Remote Desktop 

does not support Geo H264 codec, and GV-VMS V20 does not support Geo Mpeg4 codec. 

◼ UPnP: Only for GV-NVR. To automatically configure the three communication ports on 

your router, click the Arrow button beside Http Port for UPnP settings. 

◼ Remote ViewLog: Set the maximum number of users to access the recordings for 

playback from 1 to 16, and also set the idle time after which to end the playback 

application. 

 

Note: To access Remote ViewLog settings in GV-VMS V18 / V20, click Home  > 

Toolbar  > Network  > Remote ViewLog Service. 
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[Event Log Settings] Set the log storage path and duration. 

[Default Service] Select the desired services to set as default.  

 

GV-NVR 

 

Note: To access Default Service settings in GV-VMS V18 / V20, click Home  > Toolbar 

 > Configure  > System Configure > Startup. For details, see Customizing Startup 

Settings in Chapter 1 of the GV-VMS User’s Manual V18 or GV-VMS User’s Manual V20. 

 

[Prompt to accept] The client can be prompted to allow or deny the connection when 

GV-Control Center attempts to access the GV-NVR system (Remote DVR Service), or the 

client’s desktop and OS system (Remote Desktop Service).  

 

GV-NVR 

 

[Auto start default service when Windows starts] Automatically run the default services at 

Windows startup.  

[Hide when minimized] Only for GV-NVR. Hide the minimized Control Center Server 

window to the system tray. 

[Enable AES] Only for GV-VMS. Enable to secure live view and playback transmission 

through AES encryption.  

[Use Substream FIFO] Only for GV-VMS. Enable to reduce CPU usage of GV-VMS and 

improve streaming quality at the cost of increased bandwidth.

 

http://www.geovision.com.tw/download/product/GV-VMS
https://dlcdn.geovision.com.tw/Manual/VMS/EN/V20/GV-VMS_User_Manual_V20.pdf
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Chapter 3  Batch Management 
The batch functions allow you to manage a mass number of hosts without the need to visit 

each host’s interface. You can change IP addresses, rename devices, fill in identical login 

credentials, assign network storage devices to multiple hosts at a time. 

 

3.1  Configuring the IP Address 

You can set the IP addresses of multiple hosts at a time, or just change the IP address of a 

single host.  

 

Note: The batch management function is only supported by GV-Video Server, GV-IP 

Cameras, and UA-IP Cameras. 

 

1. On the Host List, click Tools  > Auto Set IP Address. The Auto Set IP Address 

dialog box appears. 

2. Select the devices to be configured from the Host Name column. To select all devices, 

click .  

3. To assign consecutive IP addresses to multiple GV-IP Devices: 

A. Configure Start IP Address, Subnet Mask, Default Gateway and DNS Server. 

B. Click the button  to preview the new IP addresses in the Assign IP column..  

5. To change the IP address of a single host, type the new IP address in the Assign IP 

field.  

4. Click Start to apply the changes. 
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3.2  Renaming Devices 

You can modify the device names of multiple hosts at a time, or just the device name of a 

single host.   

 

Note: The batch management function is only supported by GV-Video Server, GV-IP 

Cameras, and UA-IP Cameras. 

 

1. On the Host List, click Tools  > Upgrade Device Name. The Upgrade Device 

Name dialog box appears. 

2. Select the devices to be configured from the Host Name column. To select all devices, 

click the square . 

3. Type the new device name directly in the Rename field. 

4. Click Start to apply the changes. 

 
 
 

3.3  Connecting to Hosts with Identical Credentials 

When you have a mass number of hosts using the same ID and password, use the following 

method to fill in the login ID and password in the Host Settings dialog box at a time.  

 

1. On the Host List, click Tools  > Change Host ID and Password. 

2. Select hosts, type a common ID and Password. After confirming the password, click 

Start to apply the changes. 
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3. The common ID and Password are filled in the Host Settings of the selected hosts, as 

illustrated below.  

     

 

3.4  Updating Host Information 

You can update the information of multiple hosts at a time, such as the connection status, the 

total number of cameras, input and output modules installed, and their names. 

 

1. On the Host List, use the Shift key to select multiple hosts, then right-click and select 

Update.  

 

 

2. The Update Host Information window appears, with the selected hosts listed and 

selected. 

3. Click Update Information to start updating the information from hosts. 
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Chapter 4  Live View 
 

4.1  The Live View Window 

The Live View window displays live streams and gives you access to the displayed camera 

channels. You can monitor up to 100 channels simultaneously. To display live view, drag and 

drop cameras from the Host List to any live view grids. 

 

10

1
2

3
4

5

7

8

9

6
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No.  Name Description 

1 Instant Play  Play back the recordings. 

2 Snapshot  Capture a snapshot of the selected channel. 

3 Wave Out  Receive live audio from the selected channel.  

4 Microphone  

Use the camera to talk to the surveillance site. 

Note: The Microphone option in the Host List (right-click a host) is for 

talking to the host, not the site.  

5 
Live View Settings 

 

◼ Monitor: Enable / disable monitoring of the camera. 

◼ Wide Angle Lens Dewarping: Enable the dewarping setting. 

See 4.5 Adjusting the Distorted View. 

◼ Face Enroll: Enroll faces to a GV face recognition camera from 

any live views. The settings are similar to those on GV-VMS. See 

Enrolling Face Data from Live View / ViewLog in Chapter 3 of the 

GV-VMS User’s Manual V18 or GV-VMS User’s Manual V20. 

◼ Storyline: Record a sequence of different camera views of a 

specific incident. On a camera view, select Storyline to start 

recording; to add another camera view, drag the camera view to 

the recording channel. To view the storyline clip, access Log > 

the Record tab. 

◼ PTZ: Only available for PTZ cameras. Enable PTZ functions. 

◼ Apply object detection rectangles: Select to display the 

detection rectangles to highlight the detected objects. 

◼ Add to Bookmark: Bookmark an image to watch later in the 

Remote ViewLog player. The function only works when the 

channel is recording. To search for and play back bookmarked 

videos, select the Configure button  (top right of the main 

screen) > Bookmark.  

◼ Advanced Video Attributes: Adjust the brightness, contrast, 

saturation and hue of live images. 

◼ Location on Host List: Highlight the camera of the current live 

view on the Host List. 

◼ IMV1 Panomorph: Dewarp the fisheye view. Note this option is 

only available for GV-IP Cameras installed with ImmerVision 

lenses and when the camera resolution is set to 1280 x 1024 or 

higher. 

◼ VR360: Pan around the 360º image of GV-VR360. Click  or 

 to adjust the speed of the auto pan and click  to zoom 

in. 

http://www.geovision.com.tw/download/product/GV-VMS
https://dlcdn.geovision.com.tw/Manual/VMS/EN/V20/GV-VMS_User_Manual_V20.pdf
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◼ Properties:  

• Caption: Show the channel ID, host name or camera name 

on the live view. 

• Keep Image Ratio: Lock aspect ratio of the camera image.   

◼ Close: Remove the camera from the layout grid. 

6 Configure  

◼ Setup: Access System Configuration and Application Position 

settings. 

◼ Import Data / Export Data: Export / import preference settings 

and user account data. The preference settings include 

configurations in Host List, Group List, System Configuration, 

Live View, Virtual PTZ, GV-Keyboard, E-Map, and Video Wall. 

Save Configure to Other User: The Administrator can apply the 

current configurations to Power User and User accounts, 

including the live view layout, Privilege Setting (see the Note in 

section 2.3.2), System Configuration (Chapter 10) and 

Application Position (section 8.1). 

◼ Event Rules: Schedule actions based on event types. See 4.14 

Event Rules. 

◼ Bookmark: Search for and play back bookmarked videos.  

◼ GV-Keyboard / Joystick: See Appendix B. PTZ Control Using 

GV-Joystick and/or GV-Keyboard. 

◼ IP Device Utility: Access GV-IP Device Utility. 

◼ License Request Generator: Access License Activation Tool. 

◼ Version Information: Display the version number of GV-Control 

Center.  

7 Snapshot 

Take snapshots of all live view channels currently displayed. The 

images are saved to the default path C:\Control Center\Snapshot. 

To change the storage path, click Configure  (top right of the 

main screen) > Setup > System Configure > the Live View tab. 

8 Close All Videos Close all live view channels. 

9 Full Screen Extend the Live View window to full-monitor display. 

10 Monitoring Status 

Channel color (gray)  : Not monitoring  

Channel color (green) : Monitoring but not recording 

Channel color (red)   : Recording 

 

 

 

 

https://s3.amazonaws.com/geovision_downloads/Manual/Device-Utility/GV-IP_Device_Utility_Guide.pdf
https://s3.amazonaws.com/geovision_downloads/TechNotice/VMS/Licensing_GV-SW.pdf
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Note for Monitoring Status (No. 10): 

1. This function is only supported by GV-NVR / VMS, GV-IP Cameras (except GV-ABL / 

ADR / AVD / EBD / TBL / TDR / TVD series, GV-SD2322-IR / 2722-IR / 3732-IR, 

GV-QSD series). 

2. For GV-NVR / VMS, make sure that the account used for connecting to GV-Control 

Center has the privilege to enable monitoring.  

Note for GV-VR360: 

1. To view the dewarped image of GV-VR360, the graphics card must support DirectX 

10.1 or above.  

2. Up to 2 GV-VR360 can be connected to one GV-Control Center with a total frame rate 

of 24 fps. 

 

 

4.1.1  Quick Access to Other Functions on Live View 

The live view screen can be controlled using the actions below. 

Actions Functions 

Mouse scroll Zoom in or out on the live view. 

Double-click Display the live view in full screen. 

 

In the Host List, right-click a camera channel, from a host, to access the following options, 

when enabled or supported: 

    

 

Option Functions 

Focus View Setup Create up to 7 close-up views for the camera. See 4.2.2 Setting 

Focus View. 

PTZ Setup Enable PTZ functions. See 4.4 Panoramic PTZ View. 

Fisheye Option Access fisheye dewarping settings. See 4.3 Fisheye View 

Remote ViewLog Access the recordings of host. See Chapter 5 Playback. 

Broadcast Service Accesses Audio Broadcast settings. See 4.8 Audio Broadcast. 
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In the Group List, right-click a group, to access the following options, when enabled or 

supported: 

 

 

Option Functions 

Remote ViewLog Access the recordings of grouped cameras. See Chapter 5 

Playback. 

Privilege Setting  See the Note in 2.3.2 Creating a Group. 

 

 

4.2  Live View Layouts 

4.2.1  Arranging Layouts 

1. In the Layout list, click Add  > Add New Layout. This dialog box appears. 

 

           

2. Name the new layout and select one of the three available methods under Layout Setup 

to define a layout and click OK. 

3. If you select Customize in the step above, the Customize Layout dialog box appears. 

a. Click Reset  to specify a dimension for the grid if needed. 

b. To create a large grid, select multiple rectangles and click Merge . 

c. Click OK when you are done.  

4. To create multiple layouts, repeat steps 1-3. Once done, you can switch to the desired 

layout by double-clicking it on the Layout list. 
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4.2.2  Setting up Focus View 

You can create up to 7 close-up views per camera and drag the created close-up views to the 

live view grid.  

 

1. In the Host List, right-click a camera from a host > Focus View Setup. This dialog box 

appears. 

 

 

2. Click Enable and draw boxes on the camera view to create focus views. You can 

change the color of the box if needed. 

3. Click OK. The created focus views are listed under the camera channel. 

 

        

4. You can now drag the focus views to live view grids.  

 

Note: This function is not supported by fisheye and PTZ cameras. 

 

 

4.2.3  Setting up Scan Window 

You can assign multiple cameras to a Scan Window, and each camera will be shown in 

sequence for the scan interval specified. 

 

1. Drag Scan Window from the Layout list to a live view grid. 
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2. Drag the desired cameras / hosts into the Scan Window. 

1

2

 

                        

3. Move the cursor to the Scan Window, click Tools  > Properties. This dialog box 

appears. 

          

4. To adjust the order of a camera, select a camera and click the Up  and Down  

arrows. 

5. To specify how many seconds to show the live view of each camera, set up the Display 

Interval for each camera. Optionally click  to apply the display interval to all 

cameras. 

6. To show camera names on live view, select Show Caption. 

7. To lock the original aspect ratio of the camera image, select Keep Image Ratio. 

8. Click OK. 
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4.3  Fisheye View 

The circular fisheye view can be dewarped into the following four view modes, and you can 

drag PTZ views to different angles. 

   

 

 

Quad view: 4 PTZ views 360 degree: 2 PTZ view & 1 360º view 

 

 

 

   

Dual 180 degree: 2 180º views Single view: 1 PTZ view 

 

Note:  

1. This function requires a graphics card supporting DirectX 10.1 or later. 

2. The following camera types are supported: 

 GV-Fisheye Camera 

 GV-IP Camera installed with an ImmerVision IMV1 Panorama Lens 
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4.3.1  Setting up Fisheye View 

1. To enable the dewarped view, right-click a fisheye camera from the Host List > Fisheye 

Option. By default, the fisheye view is dewarped into Quad View.  

 

2. To change the dewarped settings, right-click the fisheye view on the Fisheye Settings 

window > Fisheye Option to access the following options. 

                

◼ Camera Mode: You can choose among the following four view modes. 

• Quad view: Composed of four PTZ views. 

• 360 degree: Composed of two PTZ views and one 360º panoramic view. 

• Dual 180 degree: Composed of two 180º views. 

• Single view: Composed of one PTZ view. Click on the inset window to watch a 

close-up view on the Live View window. 

◼ Camera Position: Select Ceiling, Wall or Ground according to installation 

scenarios. 

◼ Adjust Auto Pan Speed at Top-Left Channel: Select low, medium, or high 

speed to enable Auto Pan for one PTZ view at the rotation speed of your choice. 

This option is only available in Quad view, 360 degree and Single view.  

◼ Zoom: Select Zoom In or Zoom Out and then click on the image. 

◼ Show Source Video at Top-Right Channel: You can display the circular source 

image in the top-right quadrant when Quad view is selected. 

 

◼ 360 Degree Object Tracking: Only available in 360 degree mode. Track and 
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highlight detected motion in live view.  

• Tracking: Enable the 360 Degree Object Tracking function. 

• Advanced Settings: Define the mask region, object size, dwell time and 

schedule for object tracking. For details, see 4.3.2 Object Tracking. 

◼ Guard Tour Setting: Only available in Single View mode. Enable to set up a 

virtual PTZ tour using the defined preset points on live view. For details, see 

4.3.3 Virtual PTZ Tour. 

◼ Settings: 

 

• Wide View: Increase the height of the 180-degree view when camera position is 

set to wall mount. 

  

   Wide View Disabled               Wide View Enabled 

 

• Frame Rate Control: Limit the frame rate of fisheye view to the number specified. 

Select Apply All to apply the frame rate setting to all fisheye views. 

3. Drag the dewarped fisheye views from the Host List to live view grids for display. And 

you can drag any PTZ view or 180-degree view to adjust the viewing angle. 
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4.3.2  Object Tracking 

You can set up object tracking in the fisheye view to track a moving object. The function is 

only available when the view mode is set to 360 degree. When motion is detected in the 

fisheye view, the top-right channel will start tracking the moving object, which is highlighted in 

the 360-degree view at the bottom. 

  

 

1. Set the fisheye view to 360 degree by following steps 1- 2 in 4.3.1 Setting up Fisheye 

View.  

2. On the Fisheye Settings dialog box, right-click the fisheye view > Fisheye Option > 360 

Object Tracking > Advanced Settings. This dialog box appears. 

 

◼ Mask Region: Use the mouse to outline a region where motion is ignored. 

◼ Object Size: Click the  button to pause the live view and then use the mouse 
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to outline the maximum and minimum size of the target object. 

◼ Dwell Time of Motion: When the target object stops moving, the highlighted 

region and the top-right channel will remain fixed for the number of seconds 

specified. Any new motion detected during the dwell time is ignored to prevent 

the camera view from frequently jumping from one region to another. 

◼ Disable automatic zoom adjustment during 360 Object Tracking: When 

disable, the zoom ration will be kept constant as configured  

3. To enable object tracking, on the Fisheye Settings window, right-click the fisheye view > 

Fisheye Option > 360 Object Tracking > Tracking. 
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4.3.3  Virtual PTZ Tour 

You can set up a virtual PTZ tour to monitor important spots of your surveillance site. Before 

you start, make sure your fisheye camera has been set to Single View mode. For setting up 

the view mode, see the Camera Mode option, 4.3.1 Setting up Fisheye View. 

 

1. Set the fisheye view to Single View by following steps 1 - 2 in 4.3.1 Setting up Fisheye 

View.  

2. On the Fisheye Settings window, right-click on the fisheye view > Fisheye Option > 

Guard Tour Setting. The Guard Tour Setting dialog box appears along with the Fisheye 

Settings window. 

3. On the Fisheye Settings window, move the live view to a desired starting point for the 

PTZ tour by clicking on the inset window at the bottom right. 

4. Enable the settings, type a name for the current view and click Add. This view point 

(preset point) appears under Preset ID.  

 

 

5. Specify the duration for the live view to stay at the preset point under Dwell Time. The 

default is 10 seconds. 

6. Optionally click Preview to see a preview of the preset point.  

7. Click Apply. The preset point is added to Guard Tour List.  
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8. To add more preset points, repeat the steps above. 

9. To change the order of the preset points, use the View Order dropdown list to move a 

preset point up or down the list. 

10. Optionally, click Demo to watch a preview of the PTZ tour. 

11. Select OK to start the PTZ tour. To stop the PTZ tour, disable the function on the Guard 

Tour Setting. 

 

4.4  Panoramic PTZ View 

With GV-Panoramic PTZ Camera, you can manually track a moving object on its dome view 

while monitoring all angles of a location through its fisheye view.  

 

To do this: 

1. Drag both the fisheye and PPTZ camera channels from the Host List onto the Live View 

window.  

2. Click on any place on the fisheye view. The speed dome will automatically point to the 

designated area. 
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4.5  Adjusting Distorted View 

Live images may be curved near the corners. You can use the Wide Angle Lens Dewarping 

feature to adjust image distortion. 

 

1. Click Configure  on the camera’s live view, and enable Wide Angle Lens 

Dewarping.  

2. Once enabled, click Configure  again > Wide Angle Lens Settings. 

3. Move the slider at the bottom to correct the degree of dewarping.  
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4.6  Enabling QView Display 

When having more than one monitor connected to your computer, you can click and project a 

live view onto another monitor as full screen, using the QView function.  

Click one live channel to be 

displayed on another monitor.

The selected channel is 

displayed on another monitor.

 

1. On the top right of the main screen, click Configure button  > Setup > System 

Configure. The System Configure dialog box appears. 

2. Under the Live View tab, select QView, select one monitor, and click OK. 

 

 

3. Click on the camera view you wish to project onto another monitor. The live view is 

displayed onto the monitor selected.  

4. To switch to other channels, simply click on another channel. 
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4.7  VMD Monitoring 

With the VMD (Video Motion Detection), the operator can be alerted with a pop-up display of 

live view when any of the following events occur: 

 

Basic Video Analysis Events 

Motion Detection, I/O Detection, Temperature Alarm, Face Recognition 

 

Advanced Video Analysis Events 

Crowd Detection, Advanced Unattended Object Detection, Advanced Scene Change 

Detection, Advanced Missing Object Detection 

 

AI Events: Intrusion, Loitering, Average Speed, Hard Hat Detection, AI Guard Illegal Lane 

Change, People Motion, Vehicle Motion, PVD Motion, Intrusion Triggered by Sensor, 

Social Distancing Detection, Face Mask Detection, Crowd Detection, Cross Line, Leave 

Area, Enter Area, Reflective Vest Detection, Hard Hat or Vest Detection, Smoke Detection, 

Flame Detection, Smoke or Flame Detection, Wrong-Way Detection, Mandatory Crossroad 

Stopping, OCR Detection, Shoplifting Detection, Fall Down Detection, Vehicle Attributes 

Recognition Event, Queued Traffic Event, Time Waiting Event, Abnormal Audio Detection, 

Abnormal Temperature Detection, 3rd Party Events. 

 

Note:  

1. The VMD function does not support 3rd-party IP cameras. 

2. The VMD function currently supports the following SNVRs and HD DVRs: 

SNVRs: GV-SNVR0412 / 0812 / 1612 / 3203 / 6403, GV-TNVR1620-P 

HD DVRs: GV-TXVL1610 

3. GV-Control Center supports displaying VMD (video motion detection) channels to 

GV-Decoder Box Optimal’s monitors. See 6.4 Dynamic Alerts via Control Center VMD 

Motion Detection in GV-IP Decoder Box Series and Display User’s Manual for details. 

 

https://dlcdn.geovision.com.tw/Manual/Decoder-Box/GV-IP_Decoder_Box_and_Display_Manual.pdf
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4.7.1  Running VMD 

To display pop-up events in the VMD window 

1. Drag and drop the desired cameras from the Host List to the VMD Group in the Group 

List. 

2. To select the event types for pop-up alerts, right-click the VMD Group > Video Analysis, 

and check the boxes for the desired event types under each camera. Motion Detection is 

selected by default. 

3. To open the VMD window, right-click the VMD Group > Execute VMD System. When 

motion or the selected event is detected within the camera view, the live view will pop up 

in the VMD window. 

 

[Optional] To display the same pop-up events in full screen on a secondary monitor 

4. Open the Pop-up Viewer (under No. 4 in 4.7.2 The VMD Window). 

5. Select the secondary monitor for pop-up display. 

6. Set the display mode to Double Click or Newest. See Pop-up Viewer under No. 4 in 

4.7.2 The VMD Window. 

7. Click Close. Depending on the selected mode, the live view will pop up in full screen on 

the secondary monitor either when motion or the selected event is detected within the 

camera view, or when you double-click the live view in the VMD window on the primary 

monitor. 
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4.7.2  The VMD Window 

1 3 4 5 6

7

2

 

 

No. Name Description 

1 Page Up & Down Scroll the page up and down. 

2 Refresh 

Refresh the camera view. The feature is unavailable when the 

Camera pops up in the user-defined position option is enabled  

(right-click the VMD Group > VMD System Configuration). 

3 Select Quad Set the screen division. 

4 
Show System 

Menu 

◼ Image Quality: Change the display quality to Best, Normal, or 

Low. 

◼ Host List: Display the hosts added to the VMD group in tree 

view. 

◼ Pop-up Viewer: Display pop-up events in full screen on a 

secondary monitor, while still showing them on the primary 

monitor. Choose a mode below. 

• Double Click: Double-click a live view in the VMD window to 

show it on the secondary monitor. 

• Newest: Each new pop-up on the primary monitor also 

appears on the secondary monitor automatically. 

When the event ends, the pop-up view on the primary monitor 

will close, but on the secondary monitor, it will remain for the 

specified Play Time. 

Note: On the primary monitor, you may choose to set up a dwell 

time to define the duration of the pop-up view remaining on the 

screen after the event ends. For details, see the next items 

System Configure and Event Popup in Show System Menu. 
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4 
Show System 

Menu 

◼ System Configure 

• Enables DirectDraw: Enable the DirectDraw function. 

The following monitoring options are for basic video analysis 

events. 

• Dwell Time: Define the duration of the pop-up view 

remaining on the primary monitor after the event ends, 

ranging from 3 to 60 seconds. 

• Minimum Duration: Define the interval of each event 

trigger. 

• Invoke Alarm: Enable the computer alarm upon each 

event. 

• Temperature Monitoring: Define the critical temperature 

at or beyond which the camera view will pop up. 

◼ Event Popup: Define the duration of the pop-up view 

remaining on the primary monitor after the event ends, ranging 

from 0 to 9999 seconds. By default, each pop-up remains for 

60 seconds. This monitoring option is for advanced video 

analysis events. 

◼ Sound Scheme: Define the alarm sound for different events. 

◼ Keep Image Ratio: Display the video proportionally to its 

source. 

◼ Face Event Filter: Filter and display face recognition events 

from GV-AI FR and GV-VMS based on the option of Show All / 

Show Identified Persons Only / Show Unknown Persons Only. 

5 Minimize Minimize the VMD window in the Windows taskbar. 

6 Exit Close the window. 

7 Popup View 

Right-click a pop-up view to have these settings: 

◼ Advanced Live View: Open a separate window for further 

control. 

◼ Instant Playback: Access the recordings of camera view. 

If the mode in Pop-up Viewer is set to Double-Click, double-click a 

pop-up view to display it in full screen on a secondary monitor. 

 

Note for Temperature Monitoring: 

1. The critical temperature refers to the interior temperature of the device, but not its 

operating temperature. 

2. This feature is only supported by certain GV-IP Cameras. 



 

Live View 
 

 

 41 

4 

4.7.3  Dual-Monitor Display for Extra Channels 

You can set up two monitors for VMD pop-up display when the channels cannot fit on one 

monitor. 

 

Note: For monitor resolution of 1280 x 1024 and above, up to 42 pop-up views can be 

displayed on a VMD window. For monitor resolution lower than 1280 x 1024, up to 36 

pop-up views can be displayed on a VMD window. 

 

1. In the Group List, right-click the VMD Group > VMD System Configuration. This dialog 

box appears. 

 

 

2. Select two monitors from the dropdown lists as Monitor 1 and Monitor 2. Click OK. 

3. To run the VMD, right-click the VMD Group > Execute VMD System. 

4. To set the screen division of the two monitors, click the Select Quad button on the VMD 

window and select a screen division.  

 

When the first monitor is full of pop-up camera views, the next pop-up camera view will go to 

the second monitor. 
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Applications of two VMD windows: 

The position of pop-up camera views on the VMD windows varies when you enable or disable 

the Camera pops up in the user-defined position option in the VMD System Configuration 

dialog box (right-click VMD Group > VMD System Configuration). 

 

⚫ When the option is disabled: When multiple camera views are triggered simultaneously, 

the position of pop-up views on the VMD windows is based on the sequence order of 

events detected. When the first monitor is full of pop-up views, the next pop-up view will 

go to the second monitor.  

Example: 

Both Monitor 1 and Monitor 2 are set to 4 screen divisions. When 5 camera views are 

triggered simultaneously, the first 4 camera views will pop on Monitor 1 and the last 

camera view will appear on Monitor 2. 

21

3 4
 

5

 

Monitor 1 Monitor 2 

 

⚫ When the option is enabled: The position of pop-up views on the VMD windows is 

based on the order of cameras in the VMD Group.  

Example: 

In the VMD Group, Camera A is listed as the third camera and Camera B is the fifth. 

Both monitors are set to 4 screen divisions. When the two camera views are triggered 

simultaneously, Camera A images will pop up on the third square of Monitor 1 and 

Camera B images will appear on the first square of Monitor 2. Note the order of pop-up 

views is from left to right on the VMD window.  

1
 

2

 

Monitor 1 Monitor 2 
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4.8  Audio Broadcast 

The GV-Control Center operator can use the Audio Broadcast function to speak to multiple 

hosts at one time. 

 

Note:  

1. The Audio Broadcast function supports both GV and third-party IP devices with 

speaker functions. 

2. The Audio Broadcast function is also applicable to GV-IP Speaker models with 

GV-Control Center V4.2.0 or later. See 2. Adding to GV-Control Center / GV-Edge 

Recording Manager in GV-IP Speaker User’s Guide for details. 

 

 

4.8.1  Starting the Audio Broadcast 

1. On the Host List or the Group List, click Tools  > Broadcast Service. The Broadcast 

Service window appears. 

2. On the Host List, right-click a host and select Add to Broadcast Service. 

3. To start audio broadcasting to the hosts, click the Start/Stop Broadcasting button , 

and talk into the microphone connected to the computer of GV-Control Center.  

 

 

4.8.2  The Broadcast Service Window 

1

3

4

5

2

 

 

No. Name Description 

1.  Host Enable / disable the audio broadcasting with the host.  

2.  Close Close the window. 

 

https://dlcdn.geovision.com.tw/Manual/IP_Speaker/GV-IP_Speaker_User_Guide.pdf
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3.  Setup 

◼ Select Audio File: Locate a .wav or .mp3 file to play. 

◼ Repeat Play File: Select to repeat playing the selected audio. 

◼ Always on top: Always display the window on top of the screen.  

◼ Opacity: Select the opacity level of the window from 20% (fully 

transparent) to 100% (fully opaque). 

4.  
Start/Stop 

Broadcasting 
Start / stop audio broadcasting. 

5.  Play File After selecting an audio file, click the button to start/stop playing. 
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4.9  Face Recognition Watch  

With Face Recognition Watch (FR Watch), the operator can monitor live face recognition 

events (FR events) and search event logs from the following hosts: 

 

Host Live FR Events Search Log 

GV-VMS (software) O O 

GV-AI FR (software) O X 

GV-FR Panel V2 (reader) O X 

GV-TNVR1620-P (SNVR) O X 

 

Note: 

1. The GV-VMS host integrates FR events from GV-Face Recognition Cameras. 

2. Event search using Search Log is not supported for GV-AI FR, GV-FR Panel V2, and 

GV-TNVR1620-P. 

 

1. Create a group under FR Watch Group in the Group List. 

2. Drag and drop the desired cameras from the hosts into the created group. 

3. Right-click the created group > FR Watch. The following window appears.  

1

2

3 4 5

 

No. Name Description 

1 Host List Lists cameras organized under their respective hosts. 

2 
Collapse / 

Expand 
Click to collapse or expand the Host List panel. 

3 Search Log 
Search for the host’s event logs by defining the camera, time range, 

person’s name, group, age, or gender. See 4.13 Search Log. 

4 Filter 
Select All, Identified Persons Only, or Unknown Persons Only on the 

host to display only matching live FR events. 

5 FR Events Displays live FR events from the host. 
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Tip: For instructions on displaying multiple FR Watch, AI Watch, or ASManager View 

windows upon startup, see 4.12 Position Settings. 

 

 

4.10  AI Watch 

With AI Watch, the operator can monitor AI events and search for event logs from the 

following hosts: 

 GV-VMS 

 GV-SNVRs: GV-SNVR3203 / 6403, GV-RNVRL810-P / 3240-N / 256G0-N, 

GV-TNVR1620-P 

 GV-HD DVRs: GV-TXVL1610 

 UA-SNVRs: UA-SNVRL810-P / SNVR1620-P / SNVR3240-N (integrates AI events from 

UA-IP cameras with AI functions) 

 UA-HD DVRs: UA-XVL1611 / XVR1620 (integrates AI events from UA-IP cameras with 

AI functions) 

 

1. Create a group under AI Watch Group in the Group List.  

2. Drag and drop the desired cameras from the GV-VMS / GV-SNVR / GV-HD DVR hosts or 

UA-IP cameras from the UA-SNVR / UA-HD DVR hosts into the created group. 

3. Right-click the created group > AI Watch. The following window appears.  

 

4

1

2

3 65
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No. Name Description 

1 Host List Lists cameras organized under their respective hosts. 

2 AI Event Filter 
Select the desired object types and AI event types to display only 

matching detected events. 

3 
Collapse / 

Expand 
Click to collapse or expand the Host List and AI Event Filter panels. 

4 Search Log 
Search for the host’s event logs by defining the camera, time range, 

event type, or people / vehicle attributes. See 4.13 Search Log. 

5 AI Events Displays detected AI / PVD events from the host. 

6 Settings 
Enable real-time events to be removed from the display after a set 

time. Select from: 10 Minutes, 30 Minutes, 1 Hour, or 1 Day. 

 

Tip: For instructions on displaying multiple FR Watch, AI Watch, or ASManager View 

windows upon startup, see 4.12 Position Settings. 
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4.11  ASManager View 

4.11.1  Overview 

With the ASManager View, the operator can monitor access control and LPR events from the 

GV-ASManager host, as well as lock/unlock a door, force LPR recognition, trigger an output 

device, and view access logs and LPR logs.  

 

1. Create a group under the ASManager Group in the Group List.  

2. Drag and drop the desired GV-ASManager host to the created group.  

3. Right-click the created group > ASManager View. The following window appears.  

9

2 1

8

7

3
4

6
5

 

 

No. Name Description 

1.  Event Log Display the event logs of the connected GV-ASManager.  

2.  Filter Filter the event logs by defining criteria.  

3.  Auto Select List Focus on the latest data display. 

4.  Freeze List Suspend the current data display. 

5.  Access Log 
Query for access logs by defining criteria. See the next subsection 

Access and LPR Log for details. 

6.  LPR Log 
Query for LPR logs by defining criteria. See the next subsection 

Access and LPR Log for details. 

7.  Live View Display up to 1 Live View from the cameras mapped to a door / lane. 

8.  Playback  Play back the videos attached to the events if available.  
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9.  Tree List 

Right-click a controller / door / lane, an input device to access more 

functions, such as locking/unlocking a door, forcing LPR recognition 

and triggering an output device 

 

Tip: For instructions on displaying multiple FR Watch, AI Watch, or ASManager View 

windows upon startup, see 4.12 Position Settings. 

 

 

4.11.2  Access and LPR Log 

Using Access Log and LPR Log, you can look up records, see snapshots or recognized 

license plates, track the locations of vehicles, and play back recorded videos. 

 

Defining Search Criteria 

Click the Access Log icon  or LPR Log icon  (No. 5 and No. 6, 4.11.1 Overview) to 

open the corresponding log page. The example below shows the LPR Log page. 

⚫ For Access Log, specify search criteria such as access control doors, areas (in or out), 

and card numbers. 

⚫ For LPR Log, you can narrow down the search results by specifying search criteria such 

as LPR lanes, date, license plates, and card numbers. 

 

Once the search criteria are set, click Search to see the results. 
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4.12  Position Settings 

To display multiple FR Watch, AI Watch, or ASManager View windows upon startup, follow 

the steps below. 

 

Note: Upon startup, you may open up to 4 windows for each category (FR Watch 1–4, AI 

Watch 1–4, and ASManager View 1–4), and they can run simultaneously. 

 

 

1. To enable FR Watch / AI Watch / ASManager View to be started along with GV-Control 

Center’s startup, click Group List Setting under Group List (No. 3 in 1.3.3 The Group 

List), and select FR Watch, AI Watch, or ASManager View under Application Startup 

Settings. Click OK. 

2. To number the groups so that you can adjust the resolution and position of their windows 

later, right-click a group under FR Watch Group / AI Watch Group / ASManager Group > 

Position Setting > FRWatch / AI Watch / ASManager View 1, 2, 3, or 4. 

3. Optionally adjust the resolution and position of the windows by right-clicking a group 

under FR Watch Group / AI Watch Group / ASManager Group > Application Position. 

Or, you can click Configure  > Setup > Application Position at the top right of the 

main screen. For details, see 8.1 Application Position. 

4. To enable the group to be started along with GV-Control Center’s startup, right-click the 

group under FR Watch Group / AI Watch Group / ASManager Group > Startup Group. 

 

The next time you start up GV-Control Center, the FR Watch, AI Watch, and ASManager View 

windows will be displayed according to the position you configured. 
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4.13  Search Log 

The Search Log function enables post-event review and filtering of face events and AI / PVD 

events, using detailed criteria such as device, time range, event type, and specific face / 

people / vehicle attributes. 

 

Note:  

1. For supported hosts for “Search Log – Face Recognition”, see the table in 4.9 Face 

Recognition Watch. 

2. By default, no event types are selected. 

3. Filtering by people and vehicle attributes is available only for GV-VMS V20 hosts. 

Under GV-VMS V20 hosts, filtering by people and vehicle attributes is supported only 

on cameras that provide video metadata. For the list of supported GV-IP cameras, see 

Camera’s Video Metadata Supported by GV-VMS V20 in this document. 

4. For GV-VMS V18 / V20 hosts: Before AI and PVD events can appear in the Search 

Log, ensure they are configured before recording, in the IP Cam Video Analysis and 

Advanced Motion Detection Setup dialog boxes in GV-VMS, respectively. Querying can 

only be done after recording, once these settings are in place. 

⚫ For AI event setup, including face, people, and vehicle attribute detection, see 

Video Analysis by Camera in Chapter 3 of the GV-VMS User's Manual V18 or 

GV-VMS User's Manual V20. See Face Detection for face attributes, and Video 

Metadata for people and vehicle attributes (available in V20 only). 

⚫ For PVD event setup, see Setting Up Motion Detection in Chapter 1 of the 

GV-VMS User's Manual V18 or GV-VMS User's Manual V20. 

5. The Search Log function is used to search for detection or recognition results. To 

enhance detection accuracy, refer to the camera’s user manual for various AI event 

settings. For face searches, you can adjust the Confidence parameter in the Search 

Log filter to refine the similarity of search results. 

 

https://dlcdn.geovision.com.tw/Manual/VMS/EN/V20/Camera_Features_Supported_by_GV-VMS_V20.pdf
https://dlcdn.geovision.com.tw/Manual/VMS/EN/GV-VMS_User_Manual_181.pdf
https://dlcdn.geovision.com.tw/Manual/VMS/EN/V20/GV-VMS_User_Manual_V20.pdf
https://dlcdn.geovision.com.tw/Manual/VMS/EN/GV-VMS_User_Manual_181.pdf
https://dlcdn.geovision.com.tw/Manual/VMS/EN/V20/GV-VMS_User_Manual_V20.pdf
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4.13.1  Performing a Search 

You can search using face data or by filtering event types, people attributes, or vehicle 

attributes. 

 

To begin the search, follow the steps below. 

1. Click Search Log in the FR Watch or AI Watch window (No. 3 in 4.9 Face Recognition 

Watch or No. 2 in 4.10 AI Watch). The Search Log dialog box appears. 

In FR Watch: 

 

In AI Watch: 
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2. To filter by camera model, click the  icon at the right of the All Cameras field. In the 

Camera List dialog box, select one or more cameras to include in the search. 

3. Define a time range in the Time Filter. 

4. You must select at least one of the categories to filter events: Face, Event, People, and 

Vehicle. Use the Filter dropdown list to refine the results for these categories, or 

configure the corresponding filter options in the lower section of the left panel as 

described below. 

 

After completing the preliminary steps above, continue with the specific search method that 

applies, described in the following subsections. 
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FR Watch: Searching by Face Data 

In the “Search Log – Face Recognition” window in FR Watch, follow the steps below to 

search by face data. 

 

1. Enable the Face filter. You can search recorded recognition events for both identified 

and unknown individuals by uploading a reference face image (Face Matching), or by 

name or group (Face ID), provided the name is first enrolled in the face database. You 

can also filter by face attributes such as age group and gender. 

⚫ Face Matching: Click the  button to upload a reference face image from your 

PC and search for similar recognition events. Optionally, adjust the Confidence 

parameter to set the minimum similarity threshold for search results compared to 

the uploaded face image. 

 

Note: To search recognition events across multiple GV-VMS hosts using Face 

Matching, add cameras from those hosts to the same FR Watch Group before 

uploading a reference face image and performing the search. 

 

⚫ Face ID: To search recognition events by name or group, first enable Face ID, then 

enter a person’s Name (if enrolled in the face database) or select their Group. 

Available groups include Show All, Show Identified Persons Only (those 

successfully recognized from the face database), and Show Unknown Persons 

Only. 

⚫ Age Group / Gender: Filter recognition events by face attributes such as Age 

Group and Gender, which are automatically estimated during detection. The search 

returns results that match all selected attributes simultaneously. For example, 

selecting Male and Adult shows only adult males. You can also select multiple 

values within one attribute to broaden results – for instance, Male with Teen + 

Adult + Elder returns all male age groups. 

 



 

Live View 
 

 

 55 

4 

2. Click Query. The matching face events are displayed. 

 

If you are using Face Matching, a red number in parentheses appears at the top of 

each event, indicating the similarity level between the search results and the uploaded 

reference image. The similarity percentage ranges from the set Confidence parameter 

up to 100. 

 

3. By clicking an event snapshot, you can view its playback and event details. 

4. Click the  icon on the snapshot of a recognition event to use it as a reference for 

searching other similar recognition events. This function allows you to find past 

occurrences of the same person based on facial similarity. 

 

Tip: 

1. In the Event Playback panel, click View by ViewLog  beside the playback controls to 

view the playback in ViewLog. To return to the Search Log window, click Maximize in the 

minimized Search Log window at the bottom left of the screen . 

2. To export query results, click the  icon beside the object count. 

⚫ CSV: Saves as an Excel file and an image folder. 

⚫ PDF: Saves as a PDF file. 

⚫ HTML: Saves as an HTML file. 

Note: The maximum number of query results is 10,000. 
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AI Watch: Searching by Event Types, People Attributes, or Vehicle Attributes 

In the “Search Log – Artificial Intelligence” window in AI Watch, follow the steps below to 

search by event types, people attributes, or vehicle attributes. 

 

1. Enable the Event filter and select the desired AI event types. The search returns results 

that match any of the selected event types. For example, selecting Intrusion and Cross 

Line will return both Intrusion and Cross Line events. 

Alternatively, enable People or Vehicle and filter by their respective attributes. The 

search returns results that match all selected attributes simultaneously. For example, 

selecting Male and Adult shows only adult males. You can also select multiple values 

within one attribute to broaden results – for instance, Male with Teen + Adult + Elder 

returns all male age groups. Available attributes include: 

⚫ People: Age, Gender, Upper/Lower Wear, and Accessories. 

⚫ Vehicle: Type, Color, and Brand. 

2. Click Query. The matching events are displayed. In the example below, the people 

attributes are filtered by blue upper wear. 
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3. By clicking an event snapshot, you can view its playback and event details. 

 

 

Tip: 

1. In the Event Playback panel, click View by ViewLog  beside the playback controls to 

view the playback in ViewLog. To return to the Search Log window, click Maximize in the 

minimized Search Log window at the bottom left of the screen . 

2. To export query results, click the  icon beside the object count. 

⚫ CSV: Saves as an Excel file and an image folder. 

⚫ PDF: Saves as a PDF file. 

⚫ HTML: Saves as an HTML file. 

Note: The maximum number of query results is 10,000. 
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4.14  Event Rules 

With Event Rules, the operator can schedule times and alarm actions – such as activating IP 

speakers, displaying camera views via GV-Decoder Box, and triggering outputs – based on 

event types. 

 

Note: To activate IP speakers through event rules, you must first add the GV-IP Speaker to 

the Broadcast Service by right-clicking it in the Host List and selecting Add to Broadcast 

Service. Then click the Start/Stop Broadcasting button  to enable broadcasting. 

Broadcasting must remain enabled when configuring event rules. For details, see 4.8 Audio 

Broadcast. 

 

1. Click Configure  > Event Rules. This window appears. 

 

 

2. To add an event rule, click  at the top left. The right panel appears. 

 

[Event Type / Source] Select a trigger type or source to activate event alerts: I/O Trigger, 

Camera Motion, Face Recognition, or AI Events. 

Use Action Scheduler to schedule IP speaker broadcasting or output trigger times. For details 

on using Action Scheduler to schedule IP speaker broadcasting, see 2.5 Scheduling 

Broadcasting and Dynamic Alerts via Event Triggers in GV-IP Speaker User’s Guide. 

 

Action Scheduler:  

(a) Click Add Schedule. The Schedule Setting window appears. 

(b) Set a time on any day of the week or on any date. You can preview the selected time 

https://dlcdn.geovision.com.tw/Manual/IP_Speaker/GV-IP_Speaker_User_Guide.pdf
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and date at the top of the window. 

(c) Click OK. The schedule is added to the Trigger List. 

(d) You can add multiple schedules to the Trigger List by repeating Steps (a) to (c). 

 

IO Trigger: 

(a) Click Select IO Pin under Event Source. The Select I/O Device window appears. 

(b) Select checkboxes for hosts, modules, or inputs/outputs by expanding each level as 

needed. Multiple selections are allowed. 

(c) Click OK. The total number of selected IO pins is displayed under Event Source. 

(d) Click Schedule. All time periods are selected by default. Click or drag to 

select/deselect time slots, using the left mouse button to select, right to deselect. 

(e) Click OK. 

 

Camera Motion / Face Recognition / AI Events: 

(a) Click Select Camera under Event Source. The Select Camera window appears. 

(b) Select checkboxes for hosts or cameras by expanding each level as needed. Multiple 

selections are allowed. 

(c) Click OK. The total number of selected cameras is displayed under Event Source. 

(d) Click Schedule. All time periods are selected by default. Click or drag to 

select/deselect time slots, using the left mouse button to select, right to deselect. 

(e) Click OK. 

 

[Action Type] Select how the system responds to defined event types: triggering an IP 

speaker, displaying live camera view on decoder boxes, or activating an output device.  

 

[Action Target] Specify the IP speaker, decoder box, or output device according to the 

selected Action Type. 

 

IP Speaker Play: 

(a) Click Select IP Speaker under Action Target, and select the checkbox for an IP 

speaker. 

(b) Click OK. The total number of selected IP cameras is displayed under Action Target. 

(c) Click … and select an audio file for playback. 

 

Camera Live View on Decoder Box: 

(a) Click Select Decoder Box under Action Target, and select the checkbox for a 

decoder box. 

(b) Click OK. The total number of selected decoder boxes is displayed under Action Target. 

Output Trigger: 
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(a) Click Select IO Pin under Action Target. The Select I/O Device window appears. 

(b) Select checkboxes for hosts, modules, or outputs by expanding each level as needed. 

Multiple selections are allowed. 

(c) Click OK. The total number of selected IO pins is displayed under Action Target. 

 

3. To complete the setup, click OK. 

 

After you complete the configuration, event rules will appear in red the next time you open the 

Event Rules window if an Event Source or an Action Target is not specified, or if a GV-IP 

Speaker has not been added to the Broadcast Service. 
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Chapter 5  Playback 
 
You can remotely play back recordings from the connected hosts in GV-Control Center. 

 

There are two ways to play back recordings: 

⚫ Instant Playback: To play back at a predefined duration, select Instant Play  on a 

live view. 

⚫ Remote ViewLog: To play back from any time period within the host’s timeline, use the 

Remote ViewLog player by selecting the Remote ViewLog tab on the main screen. 

 

Note:  

1. Remote playback from SD card is not supported for the following models: GV-ABL / 

TBL Series, GV-ADR / TDR Series, GV-AVD / TVD Series, GV-EBD Series, 

GV-FER5702, GV-QFER12700, GV-QSD5730 / 5731-IR, GV-SD2322-IR / 2722-IR / 

3732-IR, and UA-IP cameras.  

2. For the GV-NVR / VMS host, make sure Remote ViewLog Service (under Control 

Center Service) is enabled to grant permission for remote playback. 

3. A maximum of 16 channels playback is supported by the following SNVR models: 

GV-SNVR3203 / 6403, UA-SNVRL810-P, UA-SNVR1620-P, UA-SNVR3240-N.  

Note for GV-SNVR: 

1. The Instant Playback and audio recording backup are not supported by GV-SNVR.  

2. Only one channel of the following SNVR models can be backed up: GV-SNVR3203, 

GV-SNVR6403. 

3. When using Remote ViewLog, you cannot play back the recordings of GV-SNVR with 

other hosts together in one layout.  

 

5.1  Starting Playback 

To start the remote playback: 

1. Select the Remote ViewLog tab on the main screen. 
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2. Right-click a host / camera / group from the Host List or the Group List, and select 

Remote ViewLog. Or just drag and drop your desired camera / group to the Remote 

ViewLog window. 

3. On the timeline, click the arrows or click on the date to select a date with recordings, 

which are highlighted in blue, from a pop-up calendar. 

Date/Calendar

Camera Name

Playback Time

Calendar

           

4. Click Play . 

 

Tip: 

1. To customize the screen division of the Remote ViewLog window, use the Layout list 

(see 1.3.4 The Layout List) and drag the defined layout to the Remote ViewLog 

window. 

2. To zoom in and out of a single channel, double-click the channel in the Remote 

ViewLog window. 

Note: The playback layout only supports the cameras from the same host except for 

GV-VMS / NVR / Recording Server hosts. 
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5.2  The Remote ViewLog Window 

2

3

7 8

1

4
5

6

 

No. Name  Descriptions 

1. Camera Name Indicate the host and camera names of the channel. 

2 Snapshot  Take a snapshot of the recordings. 

3 
Playback Settings 

 

Access the following options when supported: 

◼ Close Channel: Close the playback channel. 

◼ Video Effects: Apply video effects to the recordings. 

◼ Heat Map Settings: Search for and display the heat map 

videos recorded on GV-VMS. 

◼ Add to Bookmark: Create a bookmarked video. 

◼ Keep Image Ratio: Lock the camera view to its original ratio. 

◼ Web POS Search: Search for recordings of POS events. 

4 Close All Videos Close all live view channels. 

5 Playback Menu 

Access the following options: 

◼ Search Object Index: Search for Object Index videos 

recorded in GV-NVR / VMS. 

◼ Bookmark: Search for and play back bookmarked videos. 

To create a bookmark, click the Configure button  on a 

playback view (No. 3) and select Add to Bookmark. 
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◼ Print: Print the current camera view. 

◼ Backup: Back up recordings.  

◼ Display Merging List: Display the merging events of 

recordings. 

◼ Play Setting: Access audio de-noise and GPU decoding. 

◼ Display Options: Adjust the display settings. 

◼ Path for Cache: Display the cache directory. 

6 Configure  

Access the general settings of the Control Center and other 

tools, import / export data, apply the current settings to other 

users, set up event rules, and search for bookmarked videos. 

See No. 6 in 4.1 Live View Window.  

7 Timeline Player See Timeline Player described below. 

8 Refresh Timeline 
Click to update the timeline information in Remote ViewLog, 

which does not refresh automatically. 

 

Preview Window 

Move the cursor on the timeline to see a preview of the recording. Click on the timeline to 

pause all channels at the selected time. To change the size of the preview, click Playback 

Menu  (No. 5 in 5.2 The Remote ViewLog Window) > Play Setting. 

Preview Window

Cursor Position

Recording Time
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Timeline Player 

 

 

 

Colors in the timeline: 

• Red: Motion / IO event recordings 

• Blue: Audio recordings 

• Yellow: Recordings retrieved from the SD cards of cameras when reconnecting after a 

temporary disconnection 

• Turquoise: AI event / PVD Motion event recordings 

• Green: Never Recycle recordings 

 

Tip: Click Filter  to display different event types in different colors on the timeline. To 

change an event type’s color, click its color box in the window. Note that this function is only 

available for GV-VMS V17.4.6 or later / V18.3.2 or later / V20.0.0 or later / GV-AI Guard V2.0. 
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Playback Mode Option 

By default, the Remote ViewLog is set to play back video in the Real Time mode. To change 

playback modes, click   on the Timeline Player.  

 

◼ Frame by Frame (without audio): Play back video frame by frame without audio; 

however, playback can be delayed depending on the bandwidth and computer 

performance. 

◼ Real Time: Play back video on real time. Despite saving rendering time, this method 

drops frames. 

 

A to B Playback Mode 

When playing back videos, you can set a start and an end frame for auto-playing: 

 

1. To set the start frame, click  and double-click a time on the timeline.  

2. To set the end frame, click  and double-click a time on the timeline.  

3. The start time and end time are displayed besides A and B as illustrated below. 

 

    

4. Click  to start playing back from frame A to B repeatedly. 

5. To cancel this playback mode, click  

 

Changing the Displayed Date on the Timeline 

You can directly drag the timeline to search for and view the recordings of a previous or next 

day.  

 

1. Scroll the mouse wheel forth to enlarge the timeline. The default display of the timeline is 

24 hours.  

2. Click and drag the timeline back and forth. The timeline jumps between the recording 

days. 
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Tip: Right-click on the timeline and drag a period of recording time to have a quick access 

to the following functions for GV-VMS / NVR / Recording Server hosts: Backup, Save as 

AVI, Object Search, Delete (recording files), Mark / Unmark Never Recycle. 

 

 

5.3  Backing Up Recorded Files 

1. Click Playback Menu  (No. 4 in 5.2 The Remote ViewLog Window) > Backup. The 

Backup dialog box appears. 

 

Backup dialog box 
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2. Select the destination media to back up files. 

[Media] 

◼ Using Hard Disk: Click the […] button to select the desired hard disk. 

➢ Backup Folder Name: Type a desired name for the backup folder. 

◼ Using Backup Schedule: Allows users to schedule backups to the local disk. Click 

the […] button. This dialog box appears. Choose a destination path for storing 

recorded videos and specify when the backup should run, including the days and 

time periods. 

 

[Media Information] Indicates free and used space on the local disk. 

 

3. Click the Add Time Frame button to specify the time range of recorded videos to be 

backed up and define which files to back up. The Select Backup Time dialog box 

appears. 
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[Time Period] Specify the time range of recorded videos to be backed up. 

 

[Information] Indicates the number of backup files and their total size. (Total MDB refers 

to the System Log files.) 

 

[Advanced Setting]: Click  to choose which files to back up: 

◼ Database Files: Backs up the System Log files. 

◼ Object Index Files: Backs up the Object Index files. 

◼ Never-Recycle Events Only: Only backs up the never-recycle events. 

◼ Unmark these events to be recycled after the backup is complete: After the 

backup is complete, the never-recycle events will be unmarked for recycling.  

◼ Include daylight saving rollback events: Backs up the events recorded during 

Daylight Saving Time. 

◼ Bookmarked Files: Backs up the bookmarked files. 

 

[Select Camera(s)] Select the camera(s) for backup. The number of video and audio 

files of each camera is indicated respectively, e.g., “Camera 1 1+0” means Camera 1 has 

1 video file and 0 audio file. 

◼ Video + Audio dropdown list: Select the types of video events for backup. 

 

4. Click OK to add the time frame. You can repeat step 3 to create up to 10 periods of time. 

5. To include the player to the backup files, select Include Player at the bottom right of the 

Backup dialog box, and select ViewLog or Single Player. By default, ViewLog is 

selected. If no player is selected, you can only play the backup files at the computer 

installed with GeoVision codec. 

6. Click OK in the Backup dialog box to start the backup. 

 

Note: For details on the ViewLog player, see 5.1 Starting Playback and 5.2 The Remote 

ViewLog Window. 

Tip: If you select Using Backup Schedule and a schedule is created, click the Show 

Backup Task Schedule icon  from the Windows system tray to view the backup status. 
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Chapter 6  Remote DVR / Desktop 
 

6.1  Remote DVR 

The Remote DVR service allows GV-Control Center to remotely access and configure client 

GV-NVR settings. This feature reduces the number of trips to each client’s system. 

 

Note:  

1. The Remote DVR service is not supported by GV-VMS. 

2. The Remote DVR service does not support the control of audio output, PTZ, and I/O 

devices. 

 

6.1.1  Running Remote DVR 

1. Enable Remote DVR (under Control Center Service) in client GV-NVR.   

2. In GV-Control Center, click an NVR on the Host List and select Remote DVR. 

 

If the connection is established, the main screen of client GV-NVR will be displayed on 

GV-Control Center’s desktop. At the same time, the client will have the following message, 

indicating GV-NVR is in use and has been locked. 

 

 

 

If the client wants to interrupt the connection, click the button  at the bottom right corner.  



 

Remote DVR / Desktop  
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Tip: If you want to minimize the bandwidth used while viewing client GV-NVR, you can 

connect to some cameras only. Before connecting to the client, in GV-Control Center, click 

Configure  (top right of the main screen) > Setup > Application Position. On the 

Application Position window, right-click the Remote DVR icon  > Activate 

Remote Camera to select and deselect cameras. 
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6.2  Remote Desktop 

The Remote Desktop enables the GV-Control Center operator to remotely access the 

GV-NVR / VMS desktop. The operator of GV-Control Center has full control over the 

surveillance system and Windows operation system of the client. 

 

6.2.1  Running Remote Desktop 

1. Enable Remote Desktop Service (under Control Center Service) in GV-NVR / VMS. 

2. In GV-Control Center, click a NVR / VMS on the Host List and select Remote Desktop. 

 

 

When the connection is established, the client’s desktop will appear in a separate window on 

the Control Center’s desktop. If the client is using multiple monitors, click the Monitor icon 

 to switch between them.   

 

Note: The Monitor button is only supported by GV-VMS 15.10.1.0 or later. 



 

Remote DVR / Desktop  
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6.2.2  File Transfer 

The File Transfer function is for transferring files easily between GV-Control Center and the 

client.  

 

1. Run Remote Desktop.  

2. Click the File Transfer button  on the upper left corner of the Remote Desktop. The 

File Transfer Service dialog box appears.  

3. Select the desired file to transfer to Local (GV-Control Center) or Remote (the client). 

 

 

Note: The size of one single file for transfer cannot exceed 4GB, but there is no size limit for 

multiple files. 
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6.3  Data Event Query 

You can query events from client GV-NVR / VMS by defining search criteria. The search 

results can be displayed in text or in a graph. You can also export your search results in the 

form of text, html or excel. 

 

1. Enable WebCam Server in GV-NVR / VMS. 

2. In GV-Control Center, click a NVR / VMS on the Host List and select Event Data Query. 

3. In the Event List Query page, you can define search criteria, and click the Video icon for 

event playback if available. 

Query Categoryies

Define Search Criteria
Search Results Playback WindowVideo Icon

Search Results

Video icon indicates the event is attached 

with a video allowed for playback
Playback Window

Export Search Results

Graph Search Results
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Chapter 7  I/O Central Panel 
The I/O Central Panel provides a central management solution for I/O devices from different 

hosts. Its major features include: 

 Group I/O devices from different hosts 

 Trigger I/O devices in cascade mode 

 Monitor different I/O cascade configurations at different times of the day 

 Provide quick access to triggered I/O devices by a Quick Link window 

 

Note:  

1. Configurations in the Advanced I/O Panel of the client GV-NVR / VMS and in the I/O 

Central Panel of GV-Control Center may conflict. It’s recommended that the client clean 

up the settings in the Advanced I/O Panel and render I/O control to GV-Control Center. 

2. The I/O Central Panel only supports GV-IP Devices. 

 

 

7.1  Running I/O Central Panel 

1. Drag and drop the desired hosts from the Host List to the I/O Panel Group in the Group 

List. 

2. Right-click I/O Panel Group > I/O Central Panel. 

3. When connections to hosts are established, the I/O Central Panel appears on the Control 

Center’s desktop. 
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7.2  The I/O Central Panel 

 

1 2 3 4 5 6

7

8

9

 

 

No. Name Description 

1 Configure Access Panel and Schedule settings. 

2 Mode Schedule Start /stop Mode Schedule. 

3 Toggle Quick Link 
Display the Quick Link window for quick access to triggered I/O 

devices. 

4 Advanced I/O List Style 
Display the Advanced I/O List in various styles: View/Edit, Icon 

and Detail. 

5 Expand Tree Row Expand tree branches. 

6 Collapse Tree Row Collapse tree branches. 

7 Mode Configure various cascade modes. 

8 Standard I/O List  
Display connected I/O modules. 

To rename an input or output, right-click it > Rename. 

9 Advanced I/O List  Group I/O devices in cascade mode. 
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7.3  Creating a Group for Cascade Triggers 

You can group I/O devices by function or geography. Further, the group allows cascade 

triggers, meaning that the trigger actions of one trigger can activate another trigger.   

 

For example, you might have a group called “Entrance” that contains all I/O devices installed 

at entrances. The “Entrance” group might contain other sub groups, each of which contains 

just the related I/O devices in various geographic locations:  

Group containing all I/O devices installed at entrances

Input 2 installed at the front entrance

Output 1 sub group at the kitchen

Output 3 sub group at the garage 
 

 

When Input 2 is triggered, it will trigger Output 1 and Output 3 sub-groups, and Output 1 will 

trigger Output 2 in a cascade series. 

 

 

7.3.1  Creating a Group 

1. Right-click on Advanced I/O List > Add A Group. This dialog box appears.  

 

 

2. Name the group, and enable Invoke Alarm to trigger computer alarm upon I/O trigger.  

3. Click Save. 

4. To create a cascading hierarchy, drag the desired inputs/outputs from the Standard I/O 

List to the group. 

 

Note: In the cascading hierarchy, each input can only be used once while the same output 

can be used repeatedly. 



 

 78 

7.3.2  Editing a Group 

To modify group settings, right-click a group in the Advanced I/O List > View/Edit. This dialog 

box appears. 

 

 

[Current Pin Setting] To enable this option, highlight an I/O device from the group list at the 

bottom of the dialog box. 

◼ Trigger Associated Outputs: Trigger outputs in cascade mode. Click the Finger tab to 

apply the change to all I/O devices at the same group. 

◼ Change Icon: To enable this option, select one of two displayed icons: Normal or Trigger. 

Click the Change Icon tab to change an icon. Click the Finger tab to apply the change to 

all I/O devices at the same group. 
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7.3.3  Editing an I/O Device 

In addition to editing groups, you can also edit the settings of an individual I/O device. 

Right-click an input or output in the Advanced I/O List > Setting. This dialog box appears. 

 

 

[Display Setting] Define the nature of I/O devices by color. Note that the setting only affects 

the Detail style of the Advanced I/O List. 

◼ Alarm Level: Click the dropdown list, and select one of the six default colors: Fire, Smog, 

Vibration, Intruder, Motion and Emergency. For the Level Undefined option, select Text 

Color or Background Color, and then click the Input/Output dropdown list to change its 

color. 

 

Tip: To modify the naming for default alarm levels, see 7.5 Configuring the I/O Central Panel. 

 

[Trigger Setting] 

◼ Trigger Associated Outputs: Trigger outputs in cascade mode. 

The following options are only available when an Input is selected: 

◼ Latch Trigger: Instead of a lasting output alarm, the option provides a momentary alarm 

when the input is triggered in cascade mode.  

◼ Associated Camera: Associate a camera with the input. When this option is enabled, 

you can click the input under the Advanced I/O List and select View Associate Camera 

to view its associated camera view. 

◼ Digital Input Invoke Associated Camera: Enable to pop up the associated camera view 

when the input is triggered. See 7.10 Popping up Live View After Input Trigger.   



 

 80 

7.4  I/O Monitoring 

You can watch live view, play back recordings, and access host information directly from the 

I/O Central Panel. This allows the operator to quickly check the host status when I/O events 

occur. 

In the Advanced I/O List, operators can manage I/O monitoring for groups or individual I/O 

devices, and force outputs as needed. 

 

 

7.4.1  Watching Live View 

On the I/O Central Panel, click an input > View Associated Camera to watch its 

corresponding camera view. For this function, you need to enable Associated Camera in 

7.3.3 Editing an I/O Device.  

 

7.4.2  Viewing Host Information 

You can access information on host name, alarm level and a history of trigger events. 

Right-click an input in the Advanced I/O List > Information. The Pin Information dialog box 

will appear. 

 



 

I/O Control Panel 

 81 

7 

7.4.3  Playing Back Trigger Events 

To play back recordings, click an input in the Advanced I/O List > Instant Play.  

 

Alternatively, you can play back a specific trigger event. Right-click an input in the Advanced 

I/O List > Information, select an event from the Trigger Time List, and select Instant Play. 

 

Note: To allow the remote playback, the following functions must be enabled ahead: 

• NVR / VMS: Enable recording and Remote ViewLog Service 

• GV-IP Devices: Enable recording and ViewLog Server 

 

 

7.4.4  Starting I/O Monitoring 

You can start or stop I/O monitoring for groups or individual inputs/outputs by right-clicking an 

item in the Advanced I/O List and selecting Start Monitoring or Stop Monitoring. 

 

You can also pause I/O monitoring for groups. Right-click a group in the Advanced I/O List, 

and select Pause Monitoring. This function is designed for output groups set to Toggle 

mode; when selected, the group's inputs are reset, while outputs continue alarming. For 

details on the Toggle mode, see 6.1.3 Latch Trigger in GV-VMS User's Manual V18 or 

GV-VMS User's Manual V20. 

 

https://dlcdn.geovision.com.tw/Manual/VMS/EN/GV-VMS_User_Manual_181.pdf
https://dlcdn.geovision.com.tw/Manual/VMS/EN/V20/GV-VMS_User_Manual_V20.pdf
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7.4.5  Disabling I/O Devices 

You can disable any I/O devices without interrupting the I/O monitoring.  

 

Note: This function also supports client GV-IP Devices of these firmware versions: 

GV-Compact DVR (Firmware V1.43 or later), GV-IP Camera (Firmware V1.05 or later),   

GV-Video Server (Firmware V1.45 or later)  

 

1. In the Standard I/O List, right-click a host > I/O Enable Setting. This dialog box appears. 

 

             

2. Uncheck to disable an input or output.  

3. Click OK. 

 

 

7.4.6  Forcing Output 

To manually force an output device, click the output and select Force Output.  

⚫ In the Standard I/O List, you can force the output individually. 

⚫ In the Advanced I/O List, considering cascade triggers, you can only manually force the 

output at the top level, e.g., Figure A. Outputs at sub levels cannot be forced manually, 

e.g., Figure B. 

⚫ If the output is not in a cascading hierarchy, you can force it manually, e.g., Figure C. 

 

Figure A                          Figure B                 Figure C 
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7.5  Configuring the I/O Central Panel 

On the panel toolbar, click the Configure button  > Panel Setting. This dialog box 

appears.  

 

 

[Startup] 

◼ Show Quick Link: Open the Quick Link window upon panel startup. 

◼ Start Schedule Monitoring: Start Mode Schedule upon the panel startup. For details, 

see 7.7.2 Creating a Mode Schedule. 

 

[Layout] 

◼ Always On Top: Always displays the I/O Central Panel on top of the Main Screen. 

◼ Show Host Name: Display the host name of each I/O device in the Advanced I/O List. 

◼ Use User-defined Text: Allow you to modify the text of Alarm Level (see the figure under 

7.3.3 Editing an I/O Device).  

 
 

7.6  Accessing Connection Log 

You can access the connection status of hosts. On the panel toolbar, click the Configure 

button  > View Notification. This dialog box will appear. The maximum of 1000 

messages will be logged for reference. 
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7.7  Setting Mode Schedule 

The Mode Schedule allows you to monitor surveillance sites using different I/O cascade 

configurations according to the scheduled time. For example, you may want I/O cascade 

triggers one way during business hours and another way for non-business hours. Modes can 

be switched automatically at a scheduled time.  

 

7.7.1  Creating a Mode 

1. Click the Mode dropdown list (No. 7, 7.2 The I/O Central Panel) > Mode Edit. This dialog 

box appears. 

 

 

2. Click Add, and name the created mode. You can create up to 100 modes. 

3. Click Save to return to the panel.  

4. Select the created mode from the Mode dropdown list, and create the groups in the 

Advanced I/O List.  
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7.7.2  Creating a Mode Schedule 

Define the times and days you like the panel to switch modes. 

 

1. On the panel toolbar, click the Configure button  > Schedule Setting. This dialog 

box appears. 

 

 

2. Click Add to create a schedule. This dialog box appears.  

 

 

3. Name the schedule, select a Mode, and define time and day(s) to run the mode. 

4. Click OK, and click Save to return to the panel. 

5. To start the mode schedule, click the Mode Schedule button (No. 2, 7.2 The I/O Central 

Panel) > Mode Schedule Start.   
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7.8  Quick Link 

The Quick Link window provides a quick access to triggered I/O devices. It is a separate 

window displaying all the groups established in the Advanced I/O List. The group icon flashes 

when any included I/O device is triggered. Clicking the flashing icon will bring you to the I/O 

location in the Advanced I/O List. 

⚫ To open the window, click the Toggle Quick Link button  on the panel toolbar. 

⚫ To open the window upon the panel startup, enable the Show Quick Link option in 7.5 

Configuring the I/O Central Panel. 

.  
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7.9  Editing Background Image 

With the Background Image feature, you can import a floor plan to lay out the locations of the 

I/O devices. This feature works in the Icon style of the Advanced I/O List. 

 

1. To switch to the Icon style, click the Advanced I/O List Style button  on the panel 

toolbar > Icon.   

2. Select a group in the Advanced I/O List.  

3. Right-click on the right screen > Background Image to import a graphic file. 

4. Drag the I/O icons to the desired locations on the imported map.  

5. To add images to another group, repeat steps 2 to 4. 
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7.10  Popping up Live View upon Input Trigger 

The operator can be alerted by a pop-up live view after an input device is triggered. One input 

device can trigger up to 4 camera views and a total of 16 camera views can be accessed on 

the I/O Control Panel simultaneously. 

 

1. On the panel toolbar, click the Configure button  > Panel Setting > the Notify tab. 

This dialog box appears. 

 

 

2. By default, the camera view is popped up in a separate window. Specify the Maximum 

Number of Invoked Camera Views that can be displayed when multiple input devices 

are triggered simultaneously. Up to 16 camera views can be accessed.  

3. Select Enable digital input to invoke the associated camera to activate the function. 

4. If you want to pop up the camera view on the VMD window, select VMD Integration 

Mode. For this option, you must also enable the VMD window. 

5. To map a camera to an input device, right-click an input device in the Advanced I/O List > 

Setting. This dialog box appears.  
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6. Select Associated Camera and assign up to four cameras from the dropdown list. 

7. Select Digital Input Invokes the Associated Camera. 

8. Click OK. When the input is triggered, the associated camera view will pop up. 

 

Tip: You can use a GV-Keyboard to switch the audio (microphone and speaker) of the 

pop-up view on or off. 
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Chapter 8  Multi Monitors Applications 

8.1  Application Position 

The Application Position helps you adjust the resolution and position of multiple application 

windows in GV-Control Center. 

 

Note: If GV-Control Center is displayed on a widescreen monitor, you can also utilize this 

feature to help you arrange the positions of multiple application windows. 

 

1. On the top right of the main screen, click Configure  > Setup > Application 

Position. The Application Position window appears.  
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2. Right-click an application icon, select Show to display its window on the monitor and 

manually drag the window to the desired position.  

 

 

Tip: You can freely move and place a window between or among monitors. 

 

3. To adjust the window’s resolution and access other settings, right-click the application 

window or its icon at the bottom.  

 

  

The following options are available based on the application you select:  

◼ Resolution: Select the resolution of the application window. 

◼ Show: Select / unselect to display or hide the application window on or from the 

monitor. 

◼ Activate Remote Camera: For Remote DVR only. Select the cameras of client 

GV-NVR to have remote access. 

◼ Shut down when the Control Center is closed: For I/O Central Panel only. Select to 

inactivate the I/O Central Panel when GV-Control Center is closed. 

◼ Always apply specified position: For I/O Central Panel only. Select to always show 

the I/O Central Panel at the specified position upon startup.  

◼ Set Position: Define coordinates of the application window. 
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The following options are only available for Remote E-Map: 

 

 

◼ View Type: Define the display position of live view enabled from Remote E-Map. 

• Remote E-Map: Enabled by default. Select for the camera view to appear in a 

separate window.  

• Live View: Select for the camera view to appear on the Live View window. 

• Video Wall: Select for the camera view to appear on the Video Wall.  

◼ Playback:  

• Remote E-Map: Enabled by default. Select to play back recordings in a separate 

window. 

• Control Center: Select to play back recordings in the Remote ViewLog window. 

4. Re-activate the application for the settings to apply. 

 

Note: GV-Control Center memorizes the position of the application window according to 

the latest arrangement on the monitor. When you select Show again, the application 

window is hidden from the Application Position interface, but not from the monitor the 

application window set. 
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8.2  Setting up Multiple Live Views 

After arranging the positions of multiple Live Views on monitors (8.1 Application Position), 

follow the instructions below to apply a layout and cameras to each Live View. 

 

1. Right-click the desired layout > Apply to, and select a Live View for the layout to be 

applied to.  

 

 

2. To disable the Live View from the monitor, unselect the Live View.  

3. Drag and drop cameras / groups to the Live View for display.  

 

Note:  

1. For GV-Control Center to support up to 9 Live Views, with 100 camera channels for 

each Live View, higher PC specifications are required than the minimum system 

requirements. 

2. According to your screen divisions, the Live View will reduce the received resolution 

as close to the division size as possible. For GV-IP Devices, the JPEG stream of 704 x 

480 or smaller will be changed to the MPEG stream of similar size; the JPEG stream 

higher than 704 x 480 will remain as JPEG stream. The mechanism is designed to 

reduce CPU usage and save bandwidth. 
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8.3  Quick Zoom  

When you are monitoring live views on multiple monitors, the Quick Zoom feature allows you 

to call back a desired camera view to display on the primary monitor for instant inspection.   

 

1. On the Layout List, click Tools  > Live View Quick Zoom. This dialog box appears. 

 

 

2. To identify the monitor number, click the Identify button . The monitor number is 

displayed on the live views. Following is an example of running four live views in four 

separate monitors. Click the Identify button again to disable the number. 

    

                                 

3. To display the desired camera view on the primary monitor, type its monitor number in 

the Matrix field and the camera channel. Click Zoom.   

4. To return to the previous live view, click Restore. 
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8.4  Video Wall 

GV-Video Wall is an establishment of multiple monitors on a server, blending and displaying 

various video sources and applications at the same time. GV-Control Center supports up to 

200 GV-Video Wall servers, each with a different layout. On each Video Wall, you can: 

 display up to 288 IP channels 

 freely adjust the size and position of each channel, whether it be within or across 

monitors 

 create up to 16 Zoom Windows, which display channels through manual activation 

 create up to 16 Scan Windows, which are capable of displaying up to 64 channels in turn, 

at custom time interval 

 display up to 16 web pages using Web Windows 

 play back up to 16 videos using Media Windows 

 play back up to 16 videos using Remote ViewLog 

 display live views enabled from Remote E-Map 

 display live views in up to 16 screen divisions upon event detection using the VMD 

Window 

 display up to 288 channels of customized view region of a remote monitor 

 

with GV-Video Wall license
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An application of the Video Wall 

GV-Video Wall allows you to display different applications and live views, such as Remote 

E-Map, GIS, Vital Sign Monitor, Remote Desktop and Remote ViewLog, on the defined 

monitors.  

Vital Sign Monitor

Dongle / SW License 

(Control Center + Video Wall + Vital Sign Monitor 

+ GIS)

 

Note:  

1. GV-Video Wall license is required for the function to be activated. 

2. The number of monitors supported depends on the capability of graphic cards installed in 

the Video Wall server. 

3. For the minimum system requirements of GV-Video Wall, see 1.1 Minimum System 

Requirements. 
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8.4.1  Setting up Video Wall Server 

You can build the Video Wall server on a dedicated server or with GV-Control Center. Follow 

the steps below to install and set up the Video Wall server. 

 

1. Download and install GV-Video Wall Server from our website. 

2. The Video Wall server icon is minimized to the system tray.  

Video Wall server

 

 

3. Right-click the Video Wall server icon and select Configure. This dialog box appears. 

 

 

◼ Location Name: Display the name of the local server. 

◼ Remote Desktop password: Define a password for accessing the desktop of 

GV-Video Wall from GV-Control Center. 

◼ Admin Password: Define a password for accessing the GV-Video Wall settings.  

 

 

https://www.geovision.com.tw/download/product/GV-Video%20Wall
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Note: To prevent other users from configuring GV-Video Wall at the same time, set up 

Admin Password in GV-Video Wall. Then in GV-Control Center, click the Host Settings 

button  in the Video Wall list, and set up the same Admin Password. 

  

  

 

◼ Auto run when Windows starts: Start the Video Wall service upon Windows 

startup. 

◼ Auto start service when program starts up: Start the Video Wall service upon the 

startup of Video Wall program. 

◼ Auto load the last status: Automatically load the previous Video Wall settings. 

◼ Service port: Correspond to the Connect port 5630 in GV-Control Center. 

◼ Listen port: Correspond to the Search Server port 1218 in GV-Control Center. 

◼ Monitor: Display the monitors connected to the GV-Video Wall server. 

4. Select the monitors to be used and click OK. 

5. Right-click the Video Wall server icon  and select Start Service. 

 

Note: In GV-Control Center, the Video Wall Server program is installed, launched and 

activated by default.   
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8.4.2  The Video Wall List 

 

When a host is selected: 

1

2

3

4

5

6

 

When a layout is selected: 

1

2

5

6

7

 

 

No. Name Description 

1 Add Add the hosts and layouts of the GV-Video Wall server or GV-IP 

Decoder Box. 

2 Delete Delete the hosts and layouts of the GV-Video Wall server or GV-IP 

Decoder Box. 

3 Host Settings Opens Host Settings, including layout, caption, network and 

authentication settings. 

4 Connect / 

Disconnect 

Connect/disconnect from a GV-Video Wall server or GV-IP Decoder 

Box. 

5 Video Wall Setting Opens Video Wall and Decoder Box Settings, including shutdown 

on exit, autorun on start, and layout settings. 

6 Tools Automatically set up IP addresses and names for GV-IP Decoder 

Box. 

7 Apply the Selected 

Layout 

Applies the selected layout to the host. 
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8.4.3  Creating Video Wall Layout 

Follow the steps below to add the GV-Video Wall server you have set up and configure its 

layout in GV-Control Center. 

 

1. In the Video Wall list, click the Add Host button, and select Search Server to locate 

GV-Video Wall servers on the same LAN or Video Wall to manually add a GV-Video 

Wall server. 

 

2. To create a layout, click the Add button > Add New Layout. This dialog box appears. 

 

3. Name the layout and click OK. The monitor(s) from the GV-Video Wall are displayed in 

GV-Control Center.  

 
 

4. Drag and drop hosts / groups to the monitor(s) of the GV-Video Wall. 
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5. Adjust the channel size and position. The following is an example of 6 monitors from the 

GV-Video Wall. 

Automatic adjustment 

on Monitor 1
Fitting adjustment on 

Monitor 3

Manual adjustment 

across Monitor 5 & 6

 

◼ Manual adjustment: Drag the four corners of a channel to adjust its size and 

re-position. For example, the GV-BX220D/BX220D-E channel is manually placed 

across Monitors 5 and 6. 

◼ Automatic adjustment: Right-click space on a desired monitor and select Auto 

Arrange. The channels on the selected monitor are automatically reshaped to equal 

size and arranged in order (of being added to the monitor). For example, four 

channels are automatically sorted on Monitor 1. 

◼ Fitting adjustment: Right-click a channel and select Fit to Screen, the channel will 

fit the nearest monitor. For example, GV-LX4C3 is fitted to Monitor 3. 

 

Tip:  

1. To set multiple channels to the same size, drag your mouse to highlight the channels, 

right-click one of the channels and then select Setup. Define the width and height. 

2. Double-click a channel for it to extend to full-monitor size. For example, a channel 

placing across two monitors will be extended to fit the two monitors. 
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6. Right-click space of a monitor to access the following options: 

 

◼ Auto Arrange: See Automatic adjustment in step 5. 

◼ Identify Monitor: Show the monitor number. 

◼ Hide All: Inactivate and hide all the channels on the monitor. 

◼ Show All: Show all the channels on the monitor. 

◼ Use Desktop Image: Use the desktop image on the monitor. And select Update 

Desktop Image to refresh the desktop image from the Video Wall server. 

7. Right-click a channel to access the following options: 
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◼ Setup: Define the position, size and captions of the channel. 

◼ Zoom Mapping: See Setting up a Zoom Window later in this section. 

◼ Fit to Screen: See Fitting adjustment in step 5. 

◼ Lock/Unlock: Lock or unlock the channel at its current position.  

◼ Activate: Activates the channel on the GV-Video Wall. 

◼ Zoom: See Setting up a Zoom Window later in this section. 

◼ Hide: Inactivate and hide the channel. To show a hidden channel, right-click its icon 

at the bottom of the layout and select Show. 

◼ Fixed Ratio: Set the camera view proportional to its source image. 

◼ Geo Fisheye: Only for the fisheye camera. Activate the display settings configured in 

Fisheye Option.  

◼ Fisheye Option: Only for the fisheye camera. Define fisheye display settings. For 

detail, see 4.3 Fisheye View. 

◼ Wide Angle Lens Dewarping: Enable dewarping to the channel.  

◼ Wide Angle Lens Setting: Define the degree of dewarping. See 4.5 Adjusting 

Distorted View. 

◼ Location on E-Map: Show the position of the channel on Remote E-Map.  

◼ Auto Arrange: See Automatic adjustment in step 5. 
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8.4.4  Advanced Layout Settings 

You may also use the controls on the Layout Tool to adjust the channel layout and size. 

 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17

 

 

No. Name Description 

1 Align Left Aligns the selected channels to the left of the reference 

channel. Drag-select desired channels and the last 

selected one will be the reference channel. 

2 
Align Right Aligns the selected channels to the right of the reference 

channel. Drag-select desired channels and the last 

selected one will be the reference channel. 

3 Align Top Aligns the selected channels to the top of the reference 

channel. Drag-select desired channels and the last 

selected one will be the reference channel. 

4 Align Bottom Aligns the selected channels to the bottom of the reference 

channel. Drag-select desired channels and the last 

selected one will be the reference channel. 

5 Make Same Width Makes the selected channels the same width as the 

reference channel. Drag-select desired channels and the 

last selected one will be the reference channel. 

6 Make Same Height Makes the selected channels the same height as the 

reference channel. Drag-select desired channels and the 

last selected one will be the reference channel. 

7 Make Same Size Makes the selected channels the same size as the 

reference channel. Drag-select desired channels and the 

last selected one will be the reference channel. 

8 Auto Layout Automatically reshapes the channels to equal size and 

rearranges the channels in order. 

9 View Gridlines Shows or hide the auxiliary lines to precisely position the 

channels. 

10 Settings Contains settings for monitor selection and channel 

division. 
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11 Expand Horizontally Reshapes and aligns the selected channels horizontally to 

the reference channel. Drag-select desired channels and 

the last selected one will be the reference channel. 

12 Expand Vertically Reshapes and aligns the selected channels vertically to 

the reference channel. Drag-select desired channels and 

the last selected one will be the reference channel. 

13 Identify Monitor Shows the monitor number. 

14 Hide All Inactivates and hides all the channels. 

15  Show All Show all the channels on the layout. 

16 Use Desktop Image Use the desktop image on the layout 

17  Update Desktop Image Refreshes the Video Wall with desktop image. This option 

is only available when Use Desktop Image is enabled. 
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8.4.5  Activating the Channel and Layout 

After you have set up at least one layout, you can activate a channel at a time or all the 

channels of a layout at once. The activated channel or layout will be displayed on the Video 

Wall. 

 To activate a channel, right-click the channel and select Activate. You can repeat this 

operation with another desired channel. 
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8.4.6  Setting Up a Zoom Window 

A Zoom Window is a window reserved for displaying zoomed channels. Up to 16 Zoom 

Windows can be established. 

 

1. Drag the Zoom Window icon from the Channel List at the bottom to a desired monitor. 

The Zoom Window (1) is created by default. 

 

2. Adjust the position and size of the created Zoom Window. For details, see Step 5 in 8.4.3 

Creating Video Wall Layout. 

3. Make sure the channels intended for zoomed view are activated. Right-click the channel 

and select Activate.  

4. Right-click the channel again and select Zoom. The channel is displayed on the Zoom 

Window. 

5. To disable zooming, right-click the channel and select Zoom again.  

6. When the Zoom Window already displays a zoomed view, you can replace the view by 

right-clicking another channel and selecting Zoom. 



 

 108 

7. To add another Zoom Window, right-click the space in Channel List, select Add Zoom 

Window, drag the new Zoom icon to a desired monitor. To display on the new Zoom 

Window, right-click a channel and select Zoom Mapping to select the window. 

8. To delete a Zoom Window, right-click its icon on the Channel List and select Remove. 

 

Note:  

1. To set the size of Zoom Window proportional to the source video, right-click the window 

and select Fixed Ratio. 

2. To operate the Zoom Window using GV-Keyboard V3, see 2.6 GV-Video Wall in the 

GV-Keyboard V3 User’s Manual. 

 

https://dlcdn.geovision.com.tw/Manual/Keyboard/GV-KeyboardV3_User_Manual-KBV3-F-EN.zip
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8.4.7  Setting Up a Scan Window 

With a Scan Window, you can reserve a portion of the Video Wall to display a group of 

channels in turn. Up to 16 Scan Windows can be established and a Scan Window can 

display up to 64 channels in turn. 

 

1. Establish a Group with the channels for scan display.  

2. Drag a Scan Window icon from the Channel List to a desired monitor. Scan Window (1) 

is created by default. 

 

3. Adjust the position and size of the created Scan Window. For details, see Step 5 in 8.4.3 

Creating Video Wall Layout. 
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4. To configure the scan display settings, right-click the Scan Window, select Setup. This 

dialog box appears. 

 

[Scan Setting] 

◼ Display Interval: displays channels at the specified interval. The default is 3 

seconds. 

◼ Division: the channels are displayed in the specified divisions. 

 

Note: For megapixel channels, it is strongly recommended to set the Display Interval to 

at least 10 seconds to compensate for longer connection and processing time. 

 

5. Drag and drop the established group to the Scan Window. 

6. To activate scan display, right-click the Scan Window and select Activate. The channels 

are displayed by turn on the Scan Window at the specified interval. 

7. To inactivate scan display, right-click the Scan Window and select Activate again.  

8. To add another Scan Window, right-click the space in Channel List, select Add Scan 

Window and repeat Steps 1 to 6. 

9. To remove a Scan Window, right-click its icon in Channel List and select Remove.   
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To zoom a Scan Window 

1. If only one Zoom Window is set up, right-click the activated Scan Window and select 

Zoom. The channels are displayed in turn on the Zoom Window and disappear on the 

original Scan Window. 

2. If more than one Zoom Windows are set up, right-click the activated Scan Window, select 

Zoom Mapping, select a Zoom Window. The channels are displayed in turn on the 

selected Zoom Window and disappear on the original Scan Window. 

3. To disable zooming, right-click the activated Scan Window and select Zoom again. The 

channels return to the original Scan Window. 

 

Note: To operate the Scan Window using GV-Keyboard V3, see 2.6 GV-Video Wall in the 

GV-Keyboard V3 User’s Manual. 

 

https://dlcdn.geovision.com.tw/Manual/Keyboard/GV-KeyboardV3_User_Manual-KBV3-F-EN.zip
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8.4.8  Displaying Remote Monitor, Web Page and Playing 

Back Videos 

 

Displaying a Remote Monitor on Video Wall 

You can display customized view region of a remote monitor as a channel on Video Wall. Up 

to 288 Remote Monitor channels can be displayed. 

 

1. Install the Remote Desktop server to the remote server you intend to access. 

A. Insert the Software DVD to the server, select Install GeoVision Paid Software and 

click Yes to accept the License Agreement. 

B. Click GV-Remote Desktop Service and follow the on-screen instructions. The 

Remote Desktop server is installed shortly and automatically enabled. The RDS 

icon  appears in the system tray. 

2. Define the display area of the remote server and access other settings. 

A. Right-click the RDS icon  and select Stop Service. 

B. Right-click the RDS icon  again and select Configure. This dialog box appears. 
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◼ Autorun When Windows Starts: automatically activates Remote Desktop 

Service when Windows starts. 

◼ Refresh Rate: defines how quickly this remote server refreshes while being 

accessed. By default, the Slow option is selected. 

◼ Service Port: corresponds to the Data port for Remote Desktop Service in 

Control Center Server. By default it is 5632. 

◼ Password: sets a password requirement for any remote access of this 

server.  

C. If the remote server contains more than one monitor, select a monitor using the 

drop-down list under Set Viewing Range.  

D. To define the display area, select Setup and draw a square on the monitor. These 

options appear. 

◼ Save: Saves the selected display area. 

◼ Abort: Gives up the configuration. 

◼ Full Screen: Sets the display area to full screen. 

E. After you have defined the display area, click Save to store the configuration. 

F. Right-click the RDS icon  and select Start Service. 

 

Tip: To access the Data port in Control Center Server, right-click Remote Desktop Service 

from the Host List and select Add Remote Desktop. 
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3. Add and connect the Remote Desktop server to Control Center. 

A. On the Control Center’s Host List, click the Add button > Add Host > Add Remote 

Desktop. Type the IP of the remote desktop. Optionally, you can set up a password 

for remote access in the filed of Password. 

B. On the upper right corner of the Device Information section, click the Update 

Information button .  

C. The remote server and the installed monitors are shown in the Host List and 

connected to Control Center. In this example, the remote server contains one 

monitor. 

 

4. Drag the monitor to the Channel List of the Video Wall Server you wish to monitor the 

remote desktop and configure the position and size of the remote desktop on Video Wall. 

For details, see Step 5 in 8.4.3 Creating Video Wall Layout. 
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Displaying Web Pages on Video Wall 

You can display and operate up to 16 web pages on the Video Wall.  

 

 

Controls on the Web Window: 

Icon Function 

 Click to go back to the previous page. 

 Click to go to the next page. 

 Click to go to the home page. 

 Click to refresh the Web page. 

 Click to link to the specified Web address. 

Follow the steps below to display a Web page on Video Wall: 

1. Drag and drop the Web Window icon to the layout. 

2. Adjust the size and position of the Web Window. For details, Step 5 in 8.4.3 Creating 

Video Wall Layout. 

3. Type the Web address in the blank and click .  

4. To add another Web Window, right-click the space in Channel List and select Add Web 

Window. 

5. To delete a Web Window, right-click its icon in Channel List and select Remove. 
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Video Playback on Video Wall  

You can display and play back up to 16 recordings (of last 5 minutes) on Video Wall. 

 

 

1. Drag and drop the Remote ViewLog Window icon to the layout. 

6. Adjust the size and position of the Remote ViewLog Window. For details, Step 5 in 8.4.3 

Creating Video Wall Layout. 

2. Drag and drop a camera from the Host List to the Remote ViewLog Window for playback. 

Events recorded from the previous 5 minutes are played back on the Video Wall. 

3. To add another Remote ViewLog Window, right-click the space in Channel List and 

select Add Remote ViewLog Window. 

4. To delete a Remove ViewLog Window, right-click the icon in Channel List and select 

Remove. 

 

Note: Make sure you have enabled Remote ViewLog service on the GV-IP Devices and 

GV-NVR / VMS for this application. 
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Video Playback on Video Wall with Media Window 

You can play back and display up to 16 media files on Video Wall. File types supported by 

Microsoft Media Player are supported for playback in Media Window. 

 

 

1. Drag and drop the Media Window icon to the layout. 

7. Adjust the size and position of the created Media Window. For details, Step 5 in 8.4.3 

Creating Video Wall Layout. 

2. Click the Browse button to browse a file for playback. The recording is played back 

shortly. 

3. To add another Media Window, right-click the space in Channel List and select Add 

Media Window. 

4. To delete a Media Window, right-click its icon in Channel List and select Remove. 
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8.4.9  Displaying Live View from Remote E-Map 

The Video Wall can be used to display live views enabled from Remote E-Map. 

 

⚫ Make sure you have selected Video Wall for Remote E-Map’s view type. For details, see 

Step 3 in 8.1 Application Position. 

⚫ Adjust the E-Map channel size and position on the Video Wall. See Step 5 in 8.4.3 

Creating Video Wall Layout. 

 

⚫ Right-click the E-Map channel to access more settings. See Step 7 in 8.4.3 Creating 

Video Wall Layout. 

 

Tip: You can have 1, 4, 9 or 16 divisions within the Remote E-Map channel by right-clicking 

the channel, selecting Setup and then Division. 

 

⚫ When the layout is activated, live views from E-Map will be displayed on the Video Wall. 
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8.4.10  Setting Up a VMD Window 

Pop-up live views can be displayed in up to 16 screen divisions on the VMD window 

immediately whenever assigned video analysis events, e.g. motion detection, occur. 

 

1. Establish a Group with the channels for the pop-up display. 

2. Drag and drop the VMD Window icon to the layout. 

     

                           

3. To configure the display setting including the position, caption and screen divisions, 

right-click the created VMD Window and select Setup.  

4. Drag and drop the established group to the VMD Window. 

5. To activate pop-up display, right-click the VMD Window and select Activate. A live view 

will pop up upon the assigned video analysis events. 

6. To create another VMD Window, right-click the space in Channel List, select Add VMD 

Window and repeat Steps 1 to 6.  

7. To remove a VMD Window, right-click its icon and select remove. 



 

 120 

8.5  Adding GV-IP Decoder Box for Remote Monitor Display 

You can add a GV-IP Decoder Box to GV-Control Center to be assigned the desired camera 

channels for remote monitor display. For details, see 6.2 Integration to GV-Control Center / 

GV-Edge Recording Manager in GV-IP Decoder Box Series and Display User’s Manual. 

 

 

https://dlcdn.geovision.com.tw/Manual/Decoder-Box/GV-IP_Decoder_Box_and_Display_Manual.pdf
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Chapter 9  Other Applications 

9.1  Remote E-Map 

The Remote E-Map is to monitor cameras and I/O devices on a map. The Remote E-Map 

can: 

 illustrate the location of cameras and I/O devices with icons 

 illustrate the surveillance zone of cameras 

 signal motion and I/O events with blinking camera icons or blinking map areas 

 play back recordings via camera icons.  

 

Note:  

1. Third-party cameras are not supported by the Remote E-Map. 

2. The Remote E-Map also supports the access control software GV-ASManager for 

monitoring vehicle lanes and doors. For which events to trigger a blinking icon on E-Map 

and specifications, see 9.1.7 Connecting to GV-ASManager.  

3. The Remote E-Map supports casting camera views, by specified channels or upon 

motion events, to GV-IP Decoder Box Optimal. For details, see 6.3 Dynamic Alerts via 

Control Center E-Map in GV-IP Decoder Box Series and Display User’s Manual. 

 

9.1.1  Creating E-Map 

To create an E-Map file, follow the steps below. 

 

1. Drag the desired hosts from the Host List to the E-Map Group. 

 

2. To create a map for the group of hosts, right-click E-Map Group > E-Map Editor. 

https://dlcdn.geovision.com.tw/Manual/Decoder-Box/GV-IP_Decoder_Box_and_Display_Manual.pdf
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3. Click the Add Map button on the toolbar. A New Map file is created in Map View and the 

Floor Plan window separately. 

   

4. Click the New Map file in Map View, and click the Load Map button (No. 4, 9.1.2 The 

E-Map Editor Window) to import a graphic file. The file opens in the Floor Plan window.  

5. Drag and drop the icons from Host View (No. 15, 9.1.2 The E-Map Editor Window) onto 

the map in the Floor Plan window.  

6. To change the orientation of the default camera icon, right-click the camera from the Host 

View, and select an orientation. 

7. To change the camera / IO icon to your own, right-click the camera / IO from the Host 

View, and add your own icon. 

 

Note: Make sure the icon file is of 32 x 32 pixels or smaller. 

 

Define the condition that the icon appears by selecting No Event or Event and select 

the icon orientation using the drop-down list. You can set different icons for an event 

and no-event situation. In this example, the icon of IPCam.jpg appears on the map 

when no event occurs and when an event occurs, the icon changes to the default one. 

 

8. Click File in the window menu, and select Save to Control Center to save the created 

map file to the Control Center folder or Save to File to save the file to another directory. 



 

Other Applications 

 

 123 

9 

9.1.2  The E-Map Editor Window   

2

3 5

4 6

7

8

9

10
13

14

1611

12

1

15

 

No. Name  Description 

1 Up Return to the previous map file. 

2 Add Map Add a map file. 

3 Add Host Add a host folder in the Host View.  

4 Load Map Import a floor plan. 

5 Move Up Move the selected map up in the list. 

6 Move Down Move the selected map down in the list. 

7 Rename Rename a map file / folder. 

8 Delete Delete a map file / folder. 

9 Zoom In Zoom in on the floor plan. 

10 Zoom Out Zoom out on the floor plan 

11 Fit to Screen Fit the floor plan to the E-Map Editor Window. 

12 Actual Size Show the floor plan in its original size. 

13 Floor Plan The window displays the imported graphic file. 

14 Map View Tree view of map files / folders. 

15 Host View Tree view of host folders. 

16  Property  Adjust the property of view zone 
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9.1.3  Setting up the Polygonal Area 

The Polygonal Map function helps you quickly locate a triggered device. Draw an area on the 

map and it will flash when any device within the area is triggered. 

 

 

1. In the E-Map Editor window, click to highlight a map or an I/O icon, and select Edit 

Polygonal Map or Edit Polygonal IO.  

2. Click on the map to start drawing a polygonal shape, indicated by a yellow dotted line.  

 

3. After closing the shape, right-click the map and select Finish.  

 

The enclosed area will be colored in blue. When a device placed within the polygonal map is 

triggered, the blue area will flash in blue and red. 
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9.1.4  Setting up the View Zone 

The View Zone function illustrates the monitored area of each camera on the E-Map. 

 

 

1. In the E-Map Editor window, click to highlight a camera icon, and select Edit View Zone.  

2. Move the mouse to adjust the size and direction of the monitored area.  

3. Right-click the map and select Finish to finalize the zone.  

4. You can also adjust the property of the view zone from the Property menu.  

 

 



 
 

 126 

9.1.5  The Remote E-Map Window 

You can monitor events using the E-Map. When any events are detected on connected hosts, 

the associated camera or input icon on the E-Map will flash to alert the operator. Clicking the 

camera icon will bring up its live view for immediate investigation. To open the monitoring 

Remote E-Map window, right-click E-Map Group > Remote E-Map. 

 

1 2 3 4 5 6 7

9 10 11

8
 

 

No. Name  Description 

1 Login Log in up to 500 hosts. 

2 Host Information 
View the information of incoming events upon motion detected and 

I/O devices triggered. 

3 Previous Go to the previous map file. 

4 Home Back to the top of the tree view. 

5 Next Go to the next map file. 

6 ViewLog Access the Remote ViewLog function.  

7 Decoder Box 

Click and select the Decoder Box to which you want to cast the 

channels. For details, see 6.3 Dynamic Alerts via Control Center 

E-Map in GV-IP Decoder Box Series and Display User’s Manual. 

https://dlcdn.geovision.com.tw/Manual/Decoder-Box/GV-IP_Decoder_Box_and_Display_Manual.pdf
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8 Configure Configure the Remote E-Map. 

9 Tree List The list displays all created map files and folders. 

10 Blinking Icon The blinking icon represents a triggered camera or I/O device. 

11 Output Icon Click to manually force the output device. 

 

 

9.1.6  Configuring the Remote E-Map 

Click the Configure button (No. 7, 9.1.5 The Remote E-Map Window) to access the 

following settings. 

 

◼ Alert Sound: Assign a .wav file to alert the operator when cameras or input devices are 

triggered.  

◼ Camera Blink, I/O Blink: When cameras or input devices are triggered, the icons will 

flash in the map.  

◼ EMap Auto Popup: When cameras or input devices are triggered, the associated map 

will automatically pop up when the Remote E-Map window is minimized.  

◼ Show Event: Display the information of triggered events in the Host Information window. 

◼ Alert Sound & Pop-Up Camera for AS Event: Click Edit to configure advanced 

settings for AS events. 

 AS Event List: Select a GV-ASManager door event. 

 Alert Sound: Assign a .wav file to alert the operator when the selected door event 

occurs on GV-ASManager. 

 Blink: When the selected door event is triggered, the icon will flash on the map. 

 Pop-up camera for AS event: When the selected door event occurs on 

GV-ASManager, the associated live view will pop up in the Remote E-Map window. 
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◼ Hide Tree List: Hide the tree list. 

◼ Enable DirectDraw: Enabled by default to speed up graphics rendering. Some graphics 

cards might not support DirectDraw and can produce distorted frames. In such case, 

disable the function. 

◼ Use Small Icon: Display smaller icons for cameras and I/O devices. 

◼ Disable 3D EMap: Disable the 3D E-Map function. 

◼ Loop Audio Alarm: When Alert Sound is enabled, the assigned .wav file will play 

repeatedly until manually stopped by the operator. 

 

 

9.1.7  Connecting to GV-ASManager 

You can create an E-Map for access control software GV-ASManager, and place the icons of 

vehicle lanes and doors on a map. When the following door events occur, you can configure 

the associated icons to flash and the live view to pop up if a camera is mapped. For details, 

see the previous subsection 9.1.6 Configuring the Remote E-Map. 

⚫ Door Open 

⚫ Forced Open 

⚫ Duress  

⚫ Tamper  

⚫ Fire Alarm 

⚫ Held open 

⚫ Access Denied 

⚫ Tailgating 

 

Note:  

1. Make sure the Remote Monitor Server is enabled on GV-ASManager to allow remote 

access from GV-Control Center. 

2. Currently, the icon of vehicle lanes does not support any event alerts. You can only 

right-click the icon to access live view. 

3. When creating an E-Map, you can map up to 2 cameras for each Door and up to 7 

cameras for each Vehicle Lane (including 4 Recognition Cameras and the first 3 

Overview Cameras).  
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9.2  MultiLang Tool for Translated Text 

The user interface has been translated from English into 30 other languages. If you find the 

translation to be unsuitable and would like to correct it, you can use the MultiLang Tool to 

revise the translation. Then, you can apply the revised text to the application and export 

an .exe file to make the same revision to another system. You can also send the revision 

back to GeoVision to have the revision included in future software release. 

 

Revising the translated text: 

1. Download and install the MultiLang Tool from our website. 

2. Close all GeoVision applications first and double-click MultilingualConfig.exe. This 

dialog box appears. 

 

3. Click Language and select the language of the text you want to revise. 
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4. In the Search field, type all or part of the text in English or the target language and click 

Search.  

 

 

Note:   

1. The search is case sensitive. 

2. Before making any revision, click Tools and select Revision Note to read the revision 

instructions. 

 

5. Double-click the text you want to revise. This dialog box appears. 

 

6. Revise the translated text and click OK. 

 

Tip:  

1. The text may contain symbols such as %d or \n that instruct the application to perform 

certain functions. Be careful not to change the symbols in the translated text. 

2. It is recommended to revise an entire sentence at a time instead of simply searching a 

single word and replacing the word in all other strings. 
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Applying the revised text: 

1. To apply the revised translation to the application, click Save. For the following 

applications, the system will automatically locate the corresponding files on your 

computer and replace with the revised translation.  

• GV-Control Center V3.0 or later 

• GV-Video Wall Server V3.0 or later 

• GV-NVR / VMS 

• Remote ViewLog 

• GV-IP Device Utility 

• Multi View 

• Remote E-Map 

• Center V2 

• Vital Sign Monitor 

• Dispatch Server 

• GV-GIS 

• MCamCtrl Utility 

• POS Text Sender  

• Authentication Server 

• SMS Server 

• Audio Broadcast 

• Multicast 

• TwinDVR System 

• Bandwidth Control Client Site 

• Backup Viewer 

• Mobile Server 

 

2. After applying the revision, a dialog box appears to show which applications have been 

revised. Click OK. 
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3. The message “Do you want to apply the revised multilingual texts to another folder?” 

appears. If the storage path for the application has been changed or if the associated 

application is not listed in the dialog box, click Yes and select the folder of the 

application. 

 

To export or send the revised text: 

1. To export the revision as an executable file, click Tools, Export, and Export executable 

file. You can copy the .exe file to another computer and apply the same translation 

revision by running the .exe file. 

2. To report the translation revision back to GeoVision, 

• If your default mail client is Outlook, Outlook Express, or Mozilla Thunderbird, click 

Tools, Export and Send Report to send the revision. 

• If your default mail client is not set up or supported, click Tools, Export, and Export 

text file, and email the exported text file to gvlocalize@geovision.com.tw 

 

mailto:gvlocalize@geovision.com.tw
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9.3  Authentication Server 

GV-Control Center can integrate with the Authentication Server to access a specified group 

of GV-NVR / VMS hosts and thus the connected cameras of these hosts, through an 

Authentication user account.  

 

For details on the settings of GV-Authentication Server, see Authentication Server in 

Chapter 9 of the GV-VMS User’s Manual V18 or GV-VMS User’s Manual V20.. 

Follow the steps below to connect GV-Control Center to GV-Authentication Server. 

1. On the Host List, right-click Authentication Server > Add Authentication Server. The 

Use Remote Authentication Account dialog box appears. 

 

2. Under Network Setting, type the IP address of the Authentication Server.  

3. Under Server Login, type the Authorized ID, Authorized Password, and Client Name of 

the Authentication Server.  

4. Under User Account, type the Account ID and Password created on the Authentication 

Server. Optionally select Save Account to enable GV-Control Center to memorize the ID 

and Password of the Authentication Server. 

 

5. Click OK. A list of hosts assigned to the user account created on the Authentication 

Server will be displayed in the Host List. 

http://www.geovision.com.tw/download/product/GV-VMS
https://dlcdn.geovision.com.tw/Manual/VMS/EN/V20/GV-VMS_User_Manual_V20.pdf
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9.4  Multicast Setting  

In a multicast environment, a GV-VMS can send a single stream to multiple Control Center 

servers on the LAN, thereby significantly reducing the VMS server’s workload. 

 

Note: The multicast function is only supported by GV-VMS V17.1 or later.  

 

1. Add a GV-VMS host to one GV-Control Center (On the Host List, click the Add button > 

Add Host, and then select the Video Management Software catalog and the 

VMS/DVR/NVR product). 

     

 

2. Click the Multicast Setting button . 
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3. Select IP cameras to be streamed to the GV-Control Center, and select Stream 1 (main 

stream) or Stream 2 (sub stream) for live view display. Click OK. 

    

4. Add the GV-VMS host to other GV-Control Centers to enable multicasting, as described 

above. 

5. On the main screen of the GV-VMS, click Home  > Toolbar  > Network  > 

Mobile Service. This dialog box appears. 

    

 Server Port: Change the default port 56000 if necessary. 

 Enable Multicast: Enable the multicast function on the GV-VMS. 

 Multicast Address: Define a multicast address in the range of 239.0.0.0 to 

239.255.255.255.  

 Multicast Port Start: Change the default port 1000 if necessary. 

 TTL: Change the default TTL (time to live) value 5 if necessary. 

 Network Interface: Select a network address. 

 Enable AES Encryption: Enable AES encryption to secure data and video 

transmission. 
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6. Click Start. The GV-VMS is now multicasting the live stream of selected IP cameras to 

multiple GV-Control Centers. 

 

IMPORTANT: 

1. The multicast setting only enables the live stream of GV-VMS to GV-Control Center. To 

have full Control Center services, on the main screen of GV-VMS, click Home  > 

Toolbar  > Network  > Control Center Server > Control Center Service). 

2. The live view display will inherit the settings from the multicast environment if both the 

Control Center Server and the multicast setting are enabled at the same time. 
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Chapter 10  System Configuration 

On the top right of the main screen, click Configure  > Setup > System Configure to 

have system configuration settings. 

 

10.1  General Settings 

 

 

[Startup] 

◼ Autorun When Windows Starts: Automatically run GV-Control Center at Windows 

startup. 

◼ Minimize when startup: Automatically minimize the GV-Control Center window to the 

taskbar upon startup. 

◼ Full Screen: Automatically launches GV-Control Center in full screen mode upon 

startup. 

 

[Show style] 

◼ Theme: Set the color theme of user interfaces to Light or Dark. 
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10.2  Live View Settings 

 

 

[Live View] 

◼ Wave Out While App Minimized: Automatically receives live audio from the surveillance 

site when GV-Control Center is minimized to the taskbar. 

◼ Wave Out When Zoomed: Automatically receives live audio from the surveillance site 

when zooming in on its live view, when available. 

◼ Enable DirectDraw: Enabled by default. Enhances live view video performance. 

◼ Enable GPU: Enabled by default. Uses GPU decoding to reduce CPU load and increase 

the maximum frame rate. 

◼ VMS Video Quality: Select the stream quality from GV-VMS hosts (Low, Medium, or 

High). Higher quality increases network bitrate usage. 

 

[QView] 

◼ QView: When at least two monitors are connected, enable QView to project a live view 

onto another monitor as soon as the live channel is clicked. See 4.6 Enabling QView 

Display. 

 

[Snapshot] 

◼ Folder Path: Define the storage paths for snapshots. 
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10.3  Storyline Settings 

 

 

[Storyline] 

◼ Keep Image Ratio: Set the camera view proportional to its source image. 

◼ Video Resolution: Set the resolution of the camera view. 

◼ Folder Path: Define the storage paths for recordings. 
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10.4  SMTP Settings 

On the main screen, click Configure  > Setup > System Configure > SMTP Server, 

and then click Edit to set up the outgoing email server, as below. 

 

 

 

 

To configure the outgoing email server: 

1. Obtain the SMTP server hostname and port number from your email provider. 

2. Select SSL or TLS if the server requires a secure connection. 

3. Enable authentication, and type your account name and password if login credentials are 

needed. 

4. Click the Test Email Account button to send a test email and verify the setup. If the 

email fails to send, review and correct the above settings. 
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10.5  System Log Settings 

The settings allow you to set up a SQL Server account for recording the system log. For 

details, see 2. Setting up GV-Control Center in this technical notice. 

 

 

 

10.6  Exporting and Importing Settings 

10.6.1  Exporting Settings 

You can back up the settings in the Host List and live view window.  

 

1. On the main window, click Configure  > Export Data. This dialog box appears. 

 

https://dlcdn.geovision.com.tw/TechNotice/SW/SQL_Setup_for_Control_Center.pdf
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2. Select which data to export and click OK. This dialog box appears. 

 

3. Set up a password for the exported settings. This password is required when the settings 

are being imported. 

4. Click OK to confirm. Select a storage location and modify the file name if necessary. 

5. Click Save. 

 

The settings are successfully backed up. 

 

 

10.6.2  Importing Settings 

You can import the previously exported settings.  

 

1. On the main window, click Configure  > Import Data. A notification message 

appears. 

2. Click Yes to confirm. Locate a previously backed-up file and click Open. The password 

request appears. 

3. Type the password and click OK. 

4. Select which data to import and click OK. 

 

The settings are successfully imported. 
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10.7  Fast Key Settings 

On the main screen, click Configure  > Setup > Fast Key Config to enable hotkeys, as 

below. The General tab is for the Main UI, PTZ for Live View, and Playback for playback. 
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Chapter 11  Account Management 
This chapter covers account settings in GV-Control Center, including account creation, user 

privilege management, and security configuration. 

 

11.1  User 

To access account-related settings, click the account ID at the top right of the main screen > 

Account Setup. The Account Management dialog box appears. The User tab allows editing 

login credentials, creating user accounts, and managing user privileges. 

 

11.1.1  Editing Login Credentials 

See 2.2 Login Account Settings for details on changing the username and password of the 

account, and enabling automatic login. 

 

11.1.2  Creating User Accounts 

You can create user accounts. 

 

1. Click the  icon at the left to create an Administrator, Power User, or User account. 

See 11.1.3 Managing User Privileges for the differences between the user types. 
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2. Type the username and password, confirm the password, and type the password hint. 

 

 

Note: For security, your new password must be at least 8 characters long and 

include characters from at least 3 of the following 4 categories: uppercase letters 

(A-Z), lowercase letters (a-z), digits (0-9), and non-alphanumeric characters 

(`~!@#$%^&*()-_=+[]\{}|;':",./<>?). Your username must not be used as a 

password. 

 

3. To enable users to receive a reset email if they forget their password, select the user, 

expand the Email Setting option at the bottom left, and type the user's email address. 

See 10.4 SMTP Settings for details on setting up the outgoing email server. 
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11.1.3  Managing User Privileges 

Different user types have varying initial access levels, which can be adjusted by 

Administrator account users as needed. 

 

The following user types are available. 

1. Administrator: Full access to all features by default. 

2. Power User: No access to Account Management, which cannot be enabled. Initially 

restricted from specific settings — all configurable later. 

3. User: No access to Account Management, which cannot be enabled. Initially restricted 

from specific settings — all configurable later. 

 

Note: Live View Setting manages access to all controls in the Live View window. These 

privileges – Monitor Start / Stop, Advanced Video Attributes, and PTZ Control – become 

available to Administrator account users in Account Management only after Live View 

Setting is enabled. 

 

Administrator account users can adjust user privileges across 5 tabs: General, Live View, 

Remote ViewLog, Application, and Video Wall. 
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General: Live View: 

 

 

Remote ViewLog: Application 

 

 

 

Video Wall: 
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11.2  Security 

To access account-related settings, click Account Settings on the main screen > Account 

Setup > Security. The Security tab allows configuring security settings. 

 

◼ Disallow Username as Password: The username cannot be used as a password. 

◼ Login Attempt Lockout: The account will automatically lock after 3 failed attempts. 

Define the lockout duration as 5, 15, or 30 minutes. The account will automatically 

unlock after the defined duration. 

◼ Session Idle Lock: Specifies the maximum idle time for an active session before it is 

automatically locked. Options include 1, 5, 10, or 15 minutes of inactivity. 

◼ Enable Password Reset Sequence: Enables the password reset sequence. User 

identification is verified via the account's registered email. The email verification code is 

valid for 1, 5, 10, 15, or 30 minutes. 
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11.3  Account Login After Forgotten Password 

To enable users to regain access after forgetting their passwords, users must configure the 

outgoing email server, enter the recipient email address, enable the password reset 

sequence, and follow the password reset sequence. 

 

Step 1: Configure Outgoing Email Server:  

See 10.4 SMTP Settings for details on configuring the outgoing email server. 

 

Step 2: Enter Recipient Email Address 

See Step 3, 11.1.2 Creating User Accounts for details on entering the recipient’s email 

address to enable password reset verification emails. 

 

Step 3: Enable Password Reset Sequence 

See Enable Password Reset Sequence in 11.2 Security for details on enabling the account 

password reset sequence. 

 

Step 4: Regain Access After Forgetting Password 

To regain access to GV-Control Center after forgetting your password, follow the steps 

below. 

 

1. On the Login page, type the username and click Forgot Password. 
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2. In the Email Verification dialog box, the previously registered email address appears. 

Click Send. 

 

 

3. Check your email to see the verification code. 

 

 

4. In the Email Verification dialog box, type the Verification code. Optionally, click Change 

Password to reset the password. Click Next, and you can successfully log in. 
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Appendix A.  GV-USB Dongle Upgrade 
Note the following requirements and limitations for the Control Center: 

 

Dongle Requirements 

• An appropriate GV-USB dongle is required. 

• It is required to install drivers for the GV-USB dongle to work.  

• GV-USB dongle can be upgraded to include more functions, e.g. video wall.  

• Using more than one GV-USB dongles of different software on the same computer is 

possible. However, GV-Control Center and GV-Center V2 cannot be run together.  

 

Upgrading the Black Dongle 

GV-USB dongle can be upgraded to include more functions for enhancing the system. You 

need to collect the data from your dongle and send it back to GeoVision for an upgrade. The 

upgrade is a charged service. To upgrade your dongle, follow the following steps:   

 

1. Each dongle has its own serial number. Find it on the side of the dongle. Later this serial 

number will be used in naming the files for upgrading.  

 

2. Insert the dongle to the computer.  
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3. In the GV folder, double-click GVUsbKeyUpClient.exe. This dialog box appears.  

       

4. To retrieve the data from the dongle, click Select All. The information of the dongle is 

displayed in the information field. Note the displayed number of “HW Serial” should be 

the same as that on the dongle.  

5. To save the data to your local computer, click Save Key ID Data. If you have more than 

one dongle to upgrade, click Batch Save. Different dongle data will be saved as 

separate files. The file will be named after the serial number on the dongle and saved as 

*.out. For example, if a dongle serial number is 7116442, the file is named 

“NVR-7116442.out”. 

6. Send this data file to GeoVision at sales@geovision.com.tw. The GeoVision will 

examine the data file and send an *.in file back to you. The file name also includes the 

serial number of that dongle. In this example, the data file you will receive is named 

“NVR-7116442.in”. 

7. After you receive the updated file, insert the correct dongle matching the .in file you 

receive, and then run GVUsbKeyUpClient.exe.  

8. Click Select All to read the dongle, click Upgrade and then open the updated file to 

upgrade the dongle. You can also select more than one dongle in the list and click Batch 

Upgrade to upgrade them at the same time. Make sure these dongles match the 

updated files you receive.  

mailto::sales@geovision.com.tw
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Appendix B.  PTZ Control Using 

GV-Joystick and/or GV-Keyboard 

You need to run the following program in the background when using the GV-Joystick or 

GV-Keyboard to control PTZ. Up to 8 GV-Joysticks and/or GV-Keyboards can be used for 

PTZ control in Live View and Matrix.  

 

1. On the top-right corner of the main screen, click Configure  > 

GvKeyboard/Joystick. The Keyboard & Joystick dialog box appears. 

 

2. In the Device field,  

⚫ For GV-Keyboard V3, select the COM port connected to the device. 

⚫ For GV-Joystick V2 / V3, select GeoVision Joystick connected to the device. 

3. Click the Start Service button ►. Then you can use the GV-Joystick or GV-Keyboard to 

control the camera.  

4. If more than one GV-Joystick or GV-Keyboard is connected, repeat Step 2 to set up the 

device. 

  

For details on how to use the devices, see GV-Keyboard V3 User’s Manual, GV-Joystick V2 

User’s Manual, or GV-Joystick V3 Installation Guide. 

 

https://dlcdn.geovision.com.tw/Manual/Keyboard/GV-KeyboardV3_User_Manual-KBV3-F-EN.zip
https://dlcdn.geovision.com.tw/Manual/Joystick/JoystickV2/GV-Joystick_V2_User_Manual.pdf
https://dlcdn.geovision.com.tw/Manual/Joystick/JoystickV2/GV-Joystick_V2_User_Manual.pdf
https://dlcdn.geovision.com.tw/Manual/Joystick/JoystickV3/GV-JoystickV3_InstallationGuide.pdf
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Appendix C.  RTSP Streaming 

GV-Control Center supports IP video devices using RTSP standard. To connect the IP device 

compatible with RTSP standard: 

 

1. Select Protocol from the Brand dropdown list. 

 

 

2. Select one of the following options from the Model dropdown list. 

◼ GV_HTTP_SDK_RTSP: Only for GeoVision SDK users, the RTSP protocol uses a 

HTTP port for video streaming from cameras. 

◼ RTSP over HTTP: The RTSP protocol uses a HTTP port for video streaming from 

cameras.  

◼ RTSP over TCP: The RTSP protocol uses a TCP port for video streaming from 

cameras.  

◼ RTSP over UDP: The RTSP protocol uses an UDP port for video streaming from 

cameras. 

 

3. On the Command box, type the RTSP link address. For the RTSP command, please 

consult the documentation of your camera. For example: 

For an AXIS IP camera, type  

RTSP://<IP of the IP camera>/<codec>/media.amp  
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Appendix D.  Specifications 
For details on GV-Control Center specifications, see the datasheet. 

For details on GV-Video Wall specifications, see the datasheet. 

 

https://dlcdn.geovision.com.tw/Manual/Control-Center/EN/Datasheet_CC.pdf
https://dlcdn.geovision.com.tw/Manual/Control-Center/EN/Datasheet_VideoWall.pdf
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